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Activation Software feature modules for Cisco DMS are purchased and licensed separately. Features are hidden 
from all users until you purchase and install the required license to use them, and even then remain 
hidden from users whose privilege levels are low. To understand feature licenses and learn how to install 
them, see Managing Licenses for Features and Components of Cisco DMS, page 2-3. To learn how user 
access to features is restricted by the combination of licenses and user privilege levels, see 
Understanding User Roles in DMS-Admin, page 2-8. To learn which software feature modules are 
available for you to purchase, see http://www.cisco.com/go/dms.

• Overview, page 3-1

• Understanding Dashboard Gauges for Digital Signage and Enterprise TV, page 3-3

• Configuring Your DMPs to Support Centralized Management, page 3-4

• Enabling the CVBS (Composite Video) Interface on DMPs, page 3-5

• Managing and Grouping Your DMPs, page 3-6

• Configuring the Settings for an Enterprise TV Network, page 3-10

• Working with Assets and Categories in Your Media Library, page 3-27

• Working with Presentations, Templates, and Presentation Playlists for Digital Signage, page 3-33

• Using Advanced Tasks, page 3-56

• Planning for and Responding to Emergencies, page 3-66

• Scheduling Time Slots for Media and Events on DMPs, page 3-73

• Using Administrative Options, page 3-82

• Common Scenarios for Using DMM-DSM, page 3-90

Overview
Digital signage and enterprise TV consolidate certain features in Cisco DMS and interoperate in other 
important ways. Moreover, the features that you are permitted to see and use will also vary according to 
privileges that your Cisco DMS administrator has granted to your username.

• Starting Digital Signage Module (DMM-DSM), page 3-2

• Starting Enterprise TV Module (DMM-ETV), page 3-2
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  Overview
Starting Digital Signage Module (DMM-DSM)
Features of DMM-DSM provide a flexible environment in which to create, manage, and run a digital 
signage network. Simple but powerful design and publishing features help you to deliver presentations 
for digital signage, while centralized management features help you to manage a global network of 
on-premise DMP displays for any purpose. Common use cases for DMM-DSM include:

• Marketing— Describe products and services directly to your in-store customers.

• Customer experience — Deliver entertainment and information to reduce perceived wait times.

• Messaging — Broadcast executive and internal communications in real time.

• Training — Deliver cost-effective, flexible training.

• Information— Deliver real-time schedules, news, and way-faring information where people need it.

• Advertising — Sell advertising time and space to third parties.

• Branding — Communicate about your brand consistently.

Step 1 If you just logged in to DMM or if you have been using features of a software module that is not related 
to digital signage, do one of the following:

• On the DMM dashboard, click Digital Signage.

• Choose Digital Signage from the global navigation.

Starting Enterprise TV Module (DMM-ETV)
Features of DMM-ETV can help your organization to deliver video-on-demand and live broadcast TV 
channels over an IP network to DMP displays that are attached to DMP 4400G and 4305G endpoints 
(DMP 4300G endpoints are not supported). You can show live news, financial information, sales and 
marketing messages, educational content for classrooms, corporate communications, entertainment, or 
any other type of content that is suitable for your purpose. Alternatively, hospitality and healthcare 
providers might use enterprise TV features in support of in-room IPTV. 

See Configuring the Settings for an Enterprise TV Network, page 3-10.

Step 1 If you just logged in to DMM or if you have been using features of a software module that is not related 
to enterprise TV, do one of the following:

• On the DMM dashboard, click Enterprise TV.

• Choose Enterprise TVfrom the global navigation.

The TV Channels tab is preselected by default. To understand elements on this tab, see Understanding 
the TV Channels Table, page 3-13.
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Understanding Dashboard Gauges for Digital Signage and 
Enterprise TV

When you start DMM-DSM or DMM-ETV, the landing page by default is a dashboard that shows four 
gauges. This dashboard centralizes all features for monitoring DMPs, schedules, assets, and settings for 
content delivery. (Gauge data is not updated in real time; you must refresh your browser to refresh the 
dashboard.) If problems of any kind interfere with the data-collection processes that populate these 
gauges, they will show question marks in addition to the best data that is available. The gauges are as 
follows:

Table 3-1 Digital Signage and Enterprise TV Gauges

Name Description

Media and 
Schedules

The left side of the Media and Schedules gauge shows a read-only version of the unified deployment 
schedule for digital signage and enterprise TV. To exit from this dashboard and go to the editable 
schedule, click View All Schedules (to see the editable schedule, you must be logged in an 
administrator or as a user who has at least read-only permissions for the schedule). The right side of 
the Media and Schedules gauge shows the following categorized links, which are shortcuts to related 
pages and features of DMM. 

• All Digital Signage—  To see and use the entirety of this portion of the Media and Schedules 
gauge, you must be logged in as an administrator or as a user with at least read-only permissions 
to see presentations and playlists.

– Presentations— A shortcut that is equivalent to selecting Digital Signage > Presentations. To 
see and use this one shortcut specifically, you must be logged in as an administrator or as a 
user with sufficient permissions to see presentations. 

– Playlists— A shortcut that is equivalent to selecting Digital Signage > Playlists. To see and 
use this one shortcut specifically, you must be logged in as an administrator or as a user with 
sufficient permissions to see playlists. 

– Create Presentation — A shortcut that starts Digital Media Designer. See Getting Started with 
DMD, page 3-35. To see and use this one shortcut specifically, you must be logged in as an 
administrator or as a user with sufficient permissions to create presentations. 

• All Assets— To see and use the entirety of this portion of the Media and Schedules gauge, you 
must be logged in as an administrator or as a user with sufficient permissions to see assets in the 
shared media library for digital signage and enterprise TV. 

– Shortcuts (HTML, Images, UDP, Firmware, Flash, and Video) that each open the unified 
media library for digital signage and enterprise TV, filtering the result to include assets of only 
the corresponding type.

– Add Asset — Opens the Add Asset dialog box, from which you can add assets to your shared 
media library. To see and use this one element specifically, you must be logged in as an 
administrator or as a user with with sufficient permissions to add assets to at least one category 
within the shared media library for digital signage and enterprise TV. 
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Configuring Your DMPs to Support Centralized Management
You must configure your DMPs to recognize the authority of your DMM appliance, so that you can 
manage them centrally in DMM-DSM. This process occurs automatically when you autoregister DMPs, 
but if autoregistration is somehow not suitable, such as for testing purposes, you can also perform the 
required steps manually. 

• To understand autoregistration, see Managing and Grouping Your DMPs, page 3-6. 

• To learn how to use autoregistration, see the “{Add New | Edit} DMP Group” row in Table 3-2 on 
page 3-7.

DMM-DSM and your DMPs communicate over TCP port 7777 when centralized management 
is enabled.

Caution To stop untrusted DMM appliances from being able to seize control of your DMPs, you must configure 
your network firewall to restrict which devices you will permit to send inbound traffic to your DMP over 
TCP port 7777. If you do not know how to work with access control lists, see the manufacturer 
documentation for your firewall.

Digital Media 
Players

Tip The interval between polling cycles is 5 minutes, so any newly added DMP might report 
temporarily that it is unavailable; if this happens to you, wait a few minutes, then check again. 
If you notice that any of your DMPs are unreachable, see FAQs and Troubleshooting Guide for 
Cisco Digital Media System 4.x and 5.x on Cisco.com.

Shows a colored bar chart to summarize the health of DMPs in your network and counts the number of 
configured DMP groups. To see and use this gauge, you must be logged in as an administrator or as a 
user with sufficient permissions to see one DMP or one DMP group. 

• The color green represents registered DMPs that are reachable. 

• The color red represents registered DMPs that are unreachable. 

To check the free space on the SD memory card in a DMP, log in to its local instance of DMPDM, then 
click Internal Storage.

To learn more, click View All DMPs and DMP Groups or see Managing and Grouping Your DMPs, 
page 3-6. 

Enterprise TV Shows whether Enterprise TV is configured and tells you whether the most recent synchronization with 
your preferred EPG provider succeeded. To learn more, click Manage ETV. See Configuring the 
Settings for an Enterprise TV Network, page 3-10.

Settings Summarizes the most basic attributes of configured settings for your DMM appliance and ACNS 
network. To learn more, click Manage Settings or see one of these:

• Configuring DMM-DSM Server Settings, page 3-87.

• Configuring DMM-DSM to Use ACNS, page 3-87.

Table 3-1 Digital Signage and Enterprise TV Gauges (continued)

Name Description
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Caution The DMPDM login username by default is admin and the password by default is default. However, we 
urged you to change both of these when you set up your DMPs, because they are well known and 
constitute a security vulnerability in your network. To learn how to change the login credentials if you 
skipped that essential step during setup, see the quick start guide for your DMP model type on 
Cisco.com.

Do the following for each DMP that you will manage centrally.

Step 1 To log in to DMPDM, point your browser to the DMP IP address. 

Step 2 At the DMPDM login prompt, enter the username and the password that you configured for the DMP. 

Note All DMPs that you manage centrally in DMM-DSM must share one identical set of login 
credentials for DMPDM. To learn how to reconfigure your DMPs so that they all share identical 
credentials, see the quick start guide for your DMP model type on Cisco.com.

Step 3 In the Settings area, click Centralized Management, then enter the required values:

• DMM Appliance IP Address— The IP address of your DMM appliance.

• DMM-DSM Server Timeout (in seconds) — The maximum number of seconds that your DMP 
should wait for a response from your DMM appliance.

Step 4 To confirm your entries and to implement them until you change them or until you restart the DMP, 
click Apply.

Step 5 In the Administration area, to make your configuration changes permanent even after you restart your 
DMP, click Save Configuration, then (after you see the Save Configuration page) click Save.

Step 6 Click Restart DMP, then (after you see the Restart DMP page) click Restart.

Enabling the CVBS (Composite Video) Interface on DMPs
To take advantage of the latest features, options, and modern technologies, most digital signage 
environments use digital displays. However, some networks might include legacy devices and 
technologies, including analog displays. If you use analog displays or have any other reason to use 
Composite Video cables when you connect your DMPs to their displays (and if your DMPs use firmware 
release 5.0.0 or 5.0.1) you must first enable the CVBS interface on your DMPs. 

Tip This procedure is not necessary for DMPs that use firmware release 5.0.2, where DMPDM includes 
Composite as a selectable video signal type.

Step 1 Choose Digital Media Players > Advanced Tasks, then click the System Tasks row in the Application 
Types list. 

Step 2 Click Add New Application.
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Step 3 After the page is refreshed, select the required options and enter the required values for this task:

a. In the Name field, enter DMP_Enable_CVBS_(Component_Video).

b. In the Description field, enter Enable DMP support for Component Video output.

c. From the Request Type list, select Set.

d. In the Request field, enter sigma.conn=6&sigma.tvst=91&sigma.cspc=1&mib.save=1.

Step 4 To save your selections, click Submit. 

Step 5 To deploy to any of your DMPs the “DMP_Enable_CVBS_(Component_Video)” task that you defined 
and saved, see Scheduling Time Slots for Media and Events on DMPs, page 3-73.

Managing and Grouping Your DMPs
You can organize your DMPs in groups and manage them collectively instead of managing only one 
DMP at a time. We recommend that you create DMP groups to organize your DMPs according to other 
characteristics that they also have in common, such as where or how you will use them, but you can group 
your DMPs according to whatever logic works best for you. For example, the logical basis for your DMP 
groups might be geographic (by state, province, or metropolitan area) or corporate (by product team, 
sales region, time zone, primary spoken language, or type of facility), as in this illustration:

DMM-DSM includes a feature to autoregister your DMPs so that you do not have to register each DMP 
manually. We recommend that you avoid manual registration of DMPs, except for testing purposes. 
Autoregistration finds every DMP in the subnets that you specify, configures those DMPs to know and 
trust the IP address for your DMM appliance, restarts the DMPs, and registers them in DMM-DSM for 
centralized management. To learn how to use autoregistration, see the “{Add New | Edit} DMP Group” 
row in Table 3-2 on page 3-7. 

Autoregistration requires that all of the DMPs in your digital signage network share identical user 
credentials for their DMP Web Account and identical user credentials for their DMP Service Account. 
For more information, see Quick Start Guide for Cisco Digital Media Player 4305G on Cisco.com, or 
see Quick Start Guide for Cisco Digital Media Player 4400G. 

TCP port 7777 is open on DMPs and you cannot close it. DMM-DSM uses TCP port 7777 to 
communicate with DMPs.

Step 1 Choose Digital Media Players > DMP Manager.

Step 2 Select the options and enter the values that meet your requirements. 

If you do not understand your options, see Table 3-2 on page 3-7. When you make selections anywhere 
on the DMP Manager page, it is updated automatically to show the options and features that are relevant 
to your selection. 
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Note Important considerations apply to your digital signage network if any of your DMPs uses an HTTP proxy 
server. It is unusual and not scalable to manage many DMPs that share one HTTP proxy server. We 
recommend that your DMPs should not use HTTP proxy servers. 

• If your DMPs must use proxied connections, we recommend that you configure them to use Web 
Cache Communication Protocol (WCCP) instead of using a proxy server. WCCP reroutes HTTP 
requests transparently. To learn how to use WCCP if you do not already know how, see Cisco.com.

• To configure one DMP to use one proxy server, use DMPDM, not DMM-DSM. See the “Adjusting 
Basic Network Settings” topic in User Guide for Cisco Digital Media Player Device Manager 5.0 
on Cisco.com. 

• To configure many DMPs to share one proxy server, even though we recommend that you do not, 
Select Digital Media Players > Advanced Tasks, click System Tasks in the list of defined tasks, 
then click Add New Application. Enter a name and description, then select Set from the Request 
Type list and use this syntax in the Request field: 
init.BROWSER_PROXY=<on | off>&init.BROWSER_PROXY_IP=
<proxy_server_IP_address>&init.BROWSER_PROXY_PORT=<proxy_server_logical_port>.

For example, if the proxy server uses 192.168.12.12 as its IP address and delivers proxy services 
through port 5678, the Request string would look like this: init.BROWSER_PROXY=on&init.
BROWSER_PROXY_IP=192.168.12.12&init.BROWSER_PROXY_PORT=5678&mib.save=1&mng.reboot=1.

To remove that example proxy, you would select Set from the Request type list, then enter this 
Request string: init.BROWSER_PROXY_IP=&init.BROWSER_PROXY_PORT=&init.BROWSER_PROXY=off
&mib.save=1&mng.reboot=1.

Table 3-2 Elements for Managing DMPs

Element Icon and Description

DMP Groups A hierarchical tree (an object selector) of DMP groups, subgroups, and DMPs. From the object selector, you 
can add or remove group assignments for registered DMPs, create new groups, edit existing groups, and make 
selections for which DMPs the DMP List pane should describe. 

One group can contain another and the choices that you make for centralized management propagate from 
parent (DMP group), to child (DMP subgroup or DMP), to grandchild (DMP). There is no maximum number 
of levels that you can add to the hierarchy, but a simpler organization is more scalable than an unreasonably 
complex one would be. We recommend that you do not assign any DMP to the root level in the hierarchy, due 
to the complexity of management, but you can do this if you choose to.

Add New DMP Group— Shows the Add New DMP Group pane. You can save a named group for use 
in the future, even if you have not yet assigned any DMPs to it. See the “{Add New | Edit} DMP Group” 
row, elsewhere in this table.

Edit DMP Group — Shows the Edit DMP Group pane, where you can edit attributes of the group that 
you highlighted. See the “{Add New | Edit} DMP Group” row, elsewhere in this table.

Delete DMP Group — Deletes the group that you highlighted.

Opened Group — Shows the list of group members until you click to hide them.

Closed Group— Hides the list of group members until you click to show them.

DMP — A DMP that you assigned to the relevant parent group.
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DMP List A list of all DMPs contained in (or under) the level that you clicked in the DMP Groups object selector. To see 
a list of every registered DMP, click the group that represents the root level. (By default, its name is “All DMPs,” 
but this name is editable.) The interval between polling cycles is 5 minutes, so any newly added DMP might 
report temporarily that it is unavailable; if this happens to you, wait a few minutes, then check again. 
Autoregistration of 5,000 DMPs takes approximately 4 minutes in a fast network and does not use polling.

— Actions— List from which to select a presentation that you designed and saved in DMD, a VoD that you 
saved for use with enterprise TV, a task that you configured and saved on the Advanced Tasks page, or a 
task that DMM-DSM generated for you. The corresponding action will occur on the DMPs that you 
select. After you select the DMPs and the action, click Go. The specified action starts immediately.

Add New DMP — Shows the Add New DMP pane, where you enter a name, IP address, MAC address, 
and description for the DMP. 

Edit DMP— Shows the Edit DMP pane. A registered DMP might become unavailable if it receives a new 
dynamic IP address from the DHCP server at its deployment site. In this case, you should restart the DMP 
or edit the IP address record that DMM-DSM maintains for the DMP.

Delete DMP — Deletes the DMP that you highlighted.

LCD Control— Opens the LCD Control popup window, where you can configure parameters (for some 
display types manufactured by NEC and DMTECH.1) for a DMP display.

Assign DMP to Group— Creates an association between at least one DMP and at least one group. Do 
the following:

1. Click .

2. In the DMP List pane, click one or more DMPs to select them.

3. In the object selector, click one or more DMP groups that the selected DMPs should join.

4. Click  again.

Remove DMP from Group — Deletes the association between at least one DMP and at least one group. 
Do the following:

1. Click .

2. In the DMP List pane, click one or more DMPs to select them.

3. In the object selector, click one or more DMP groups from which to disassociate the selected DMPs.

4. Click  again.

— Filter— Select a filter type2 from the list, then click Go to see only the DMPs that match your filter.

— Display Number — The maximum number of rows that the table should show per page if it straddles 
multiple pages.

— Status — Says whether a DMP is reachable. A green icon ( ) tells you that the DMP is connected to a 
power source, uses a known IP address, and is reachable. A red icon ( ) tells you that the DMP is 
unreachable. 

— Name— A unique and human-readable name that you entered or that DMM-DSM chose; If DMM-DSM 
chose the name, it is either the DMP IP address or MAC address.

— IP — The public IP address at which the DMP receives instructions and data from DMM-DSM.

— Version— The release number for the installed firmware version on the DMP.

— Description— The description that you entered.

Table 3-2 Elements for Managing DMPs (continued)

Element Icon and Description
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{Add New | 
Edit} DMP 
Group

You can create or edit a DMP group. You must specify the group name and description. In addition, you can 
populate the group automatically with all of the DMPs in any NMAP address range that you specify. The address 
range can span one subnet or multiple subnets. You can schedule multiple DMP autoregistration operations to run 
simultaneously if they all search the same one subnet. If the DMP autoregistration operations that you configure do 
not all search the same one subnet, you should not schedule them to run simultaneously. If you do, only the first 
such operation will run and DMM-DSM will not show any error message to explain why the other autoregistration 
operations failed to find any DMPs. If you must run DMP autoregistration tasks that search different subnets, 
schedule a 35-minute interval between the start time for one autoregistration and the start time for the next 
autoregistration. In a very large network that contains thousands of DMPs, the required interval might be longer 
than 35 minutes. When you autoregister a DMP, it restarts immediately even if it is already centrally managed by 
a different DMM appliance than the one that you are using, and even if it is showing a presentation on its 
DMP display. Therefore, we recommend that you be careful to autoregister only those DMPs that you are not 
already managing from any of your DMM appliances. Otherwise, you might temporarily disrupt the deployment 
of presentations and their assets in your digital signage network. Autoregistration operations follow this sequence:

1. DMM-DSM scans every device in the specified address range, looking for devices where TCP port 7777 
is open. This phase fails if you have disabled the “Enable TAC Troubleshooting Access” option in 
DMPDM (which is enabled by default) and unless your firewall allows ICMP traffic to pass from your 
DMM appliance to your DMPs.

2. DMM-DSM confirms which of the devices with port 7777 open are DMPs. 

3. Those that are DMPs receive information about your DMM server, and are then instructed to restart.

4. Upon restarting, DMPs transmit updated information about themselves to DMM-DSM and set their own status 
as “Up.” 

DHCP servers at your deployment sites should be configured to expire leased IP addresses for DMPs only 
when DMPs are restarted. A registered DMP might become unavailable if it receives a new dynamic IP 
address from the DHCP server at its deployment site. In this case, you should restart the DMP or edit the 
IP address record that DMM-DSM maintains for the DMP.

5. DMM-DSM generates new database records for all DMPs that are newly autoregistered, assigns these DMPs 
to any DMP groups corresponding to the address range that you entered, and assigns them to the “All DMPs” 
group.

— Name— A unique and human-readable name for the group.

— Description— A brief description of the group and its purpose.

Add New Range — IP address subnet ranges in which to find and autoregister DMPs. The netmask 
typically is /24. To find every DMP in a subnet, use 0 (zero) as the only digit in the fourth quad, such as 
192.0.2.0/24. To find one DMP whose address is already known to you, enter its IP address and the 
netmask but use a comma instead of the fourth dot, like 192.0.2,50/24.

Delete a Range— Deletes the range that you highlighted.

— Automatic Grouping Ranges — Shows a list of all the defined NMAP address ranges. Click a range to 
edit it.

— Range (CIDR)— The field where you edit one CIDR address range at a time. For DMP autoregistration to 
succeed, the routers, switches, and firewalls that pass packets between your DMM appliance and the 
specified CIDR address range must allow TCP port 7777 to send and receive packets, and must allow ICMP 
traffic to pass from your DMM appliance to your DMPs.

Table 3-2 Elements for Managing DMPs (continued)

Element Icon and Description
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Configuring the Settings for an Enterprise TV Network

Activation Software feature modules for Cisco DMS are purchased and licensed separately. Features are hidden 
from all users until you purchase and install the required license to use them, and even then remain 
hidden from users whose privilege levels are low. To understand feature licenses and learn how to install 
them, see Managing Licenses for Features and Components of Cisco DMS, page 2-3. To learn how user 
access to features is restricted by the combination of licenses and user privilege levels, see 
Understanding User Roles in DMS-Admin, page 2-8. To learn which software feature modules are 
available for you to purchase, see http://www.cisco.com/go/dms.

Note Video-on-demand (VoD) features for enterprise TV depend upon the media library features for digital 
signage. Therefore, even though the DMM-ETV and DMM-DSM software modules are licensed 
separately and can operate independently of one another in most ways, you cannot use the VoD features 
for enterprise TV unless you have installed the licenses for both DMM-ETV and DMM-DSM. 

{Add New | 
Edit} DMP

Note We recommend that you never use manual registration, except in a lab for testing purposes; it is not 
suitable or scalable for a production network. To understand autoregistration, see the “{Add New | 
Edit} DMP Group” row, elsewhere in this table.

Make selections and enter required values to add one DMP manually.

— DMP Name— A unique and human-readable name for the DMP.

— DMP IP— The public IP address that receives instructions and data from DMM-DSM.

— DMP MAC— The MAC address that the DMP NIC uses.

— DMP Description— Optional, brief description of the DMP, its deployment site, or anything that is 
relevant or meaningful to you.

1. The DMP display properties that you can select and configure in the LCD Control popup window are as follows: 
• TV Type— Select the manufacturer and the model type {DMTECH | NEC_3210 | NEC_4010 | NEC_4610 | NEC_5710}.
• Contrast — Select or enter a contrast value from 0 to 100.
• Brightness— Select or enter a brightness value from 0 to 100.
• Sharpness — Select or enter a sharpness value from 0 to 100.
• Color — Select or enter a color value from 0 to 100.
• Tint —Select or enter a tint value from 0 to 100.
• TV Channel — Select or enter the analog television signal frequency for a channel from 0 to 99.
• Audio Volume — Select or enter a volume level from 0 to 100.
• Mute —Select whether to mute the display {on | off}.
• Input— Select the input type {TV | RGB | RGB1 (DVI-D) | RGB2 (D-SUB) | RGB3 (BNC) | DVD/HD | Video (Composite) | 

Video 1 | Video 2 | Video 3 | S-Video | None (DVD) | Component) | PC | HDMI | None (DVBT)}. Options vary according to the manufacturer 
and device model. 

• Power— Select whether the television should be turned on {on | off}.
To save your work in the LCD Control popup window, click Submit. Otherwise, to discard your work, click Cancel.

2. The filter types are as follows: ()
• Status— Select Up or Down to limit matches by DMP availability.
• Name— Enter the text string to limit matches by DMP name.
• IP — Enter any part of the “dotted quad” to limit matches by DMP IP address.
• MAC —Enter the text string to limit matches by DMP MAC address.
• Description —Enter the text string to limit matches by DMP descriptions. 
• Version— Enter the text string to limit matches by DMP firmware release version number.

Table 3-2 Elements for Managing DMPs (continued)

Element Icon and Description
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• An administrator uses DMM-ETV to: 

– Customize on-screen menus with a logo and a skin. 

– Configure video channel assignments. 

– Specify what channels and programs should be available to the DMP displays where your 
organization will deploy its enterprise TV, and when each program should be available. 

• An on-premise operator uses a remote control to navigate through live video channel menus, change 
channels, and select from video-on-demand categories. 

The features for enterprise TV in this release support deployments of fewer than 100 live broadcast 
channels. Any digital encoders that you use for these channels must adhere to the MPEG2-TS standard 
for streaming and must support at least one of these codecs: MPEG1, MPEG2 or MPEG4/h.264. We 
recommend that you use a Scientific Atlanta 9032SD encoder or 9050HD encoder to encode the video 
streams that your DMPs should use for enterprise TV channels.

This section contains these topics:

• Understanding the Typical Workflow for Enterprise TV, page 3-11

• Configuring Settings for TV Channels, page 3-12

• Configuring Subscription Settings for EPG Providers, page 3-20

• Configuring Enterprise TV Settings for Video on Demand, page 3-23

• Using ‘Skins’ to Customize the Enterprise TV Main Menu, page 3-26

Understanding the Typical Workflow for Enterprise TV
The checklist in this topic describes the ordinary workflow for enterprise TV.

Before You Begin

Complete these prerequisite tasks, in any order:

• Install the license for enterprise TV on your DMM appliance.

• Deploy DMPs and DMP displays to the sites where you will show enterprise TV.
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• Negotiate with a cable or satellite TV service in your region for the right to redistribute their package 
of TV channel signals.

• Configure one Scientific Atlanta 9032SD encoder or 9050HD encoder apiece for each TV channel 
signal that you will stream in real time.

Configuring Settings for TV Channels
This section includes the following topics:

• Understanding the TV Channels Table, page 3-13

• Adding New Channels, page 3-15

• Editing Channels, page 3-18

• Reassigning Channel Numbers, page 3-19

• Deleting Channels, page 3-19

• Listing Only the Defined (Active) or Undefined (Inactive) TV Channels, page 3-19

Task

1. Use elements on the EPG Skins tab to enable or disable the electronic program guide (EPG) for 
enterprise TV.

If you enable this feature, people at your deployment sites can use a handheld remote control to browse on-screen 
program listings and select programs to watch. See Using ‘Skins’ to Customize the Enterprise TV Main Menu, 
page 3-26.

2. (You can skip this task if you will not use the EPG.)
Choose the EPG-population method for each channel that the EPG will describe.

• You can enter a brief message one time that describes the channel in a broad and general sense. This 
description straddles all time slots. 

• You can enter descriptions into a CSV file for each program that the channel will show.

• You can negotiate with a vendor of programming data to establish a paid subscription, by which you will gain 
automatic access to current program schedules and descriptions for multiple channels. 

See the “EPG Provider” row in Table 3-4 on page 3-15.

3. (You can skip this task if you will not use the EPG, and also if you do not have any EPG data subscription.)
Use elements on the EPG Providers tab to:

a. Enter login credentials for your subscription. See Adding or Editing Subscriptions to Data from an EPG 
Provider, page 3-21.

b. Obtain and then synchronize the schedule and description data for programs. See Synchronizing TV Channel 
Schedules and Program Descriptions for the EPG, page 3-22.

4. (You can skip this task if your DMM appliance has direct Internet access.)
If your DMM appliance should use a proxy server to obtain data from your preferred EPG data service 
provider, configure a SOCKS proxy for enterprise TV. 

See rows in the “Proxy Settings (Optional)” area of Table 3-5 on page 3-21. 
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Understanding the TV Channels Table

When you select Enterprise TV > TV Channels, a table is shown that describes the defined and 
undefined TV channels for your network. You can work with this table in many ways.

Table 3-3 Elements of the TV Channels Table

Element Description

Channel View list Enables or disables a filtered view of which channels this table describes, based on which 
option you select:

• All Channels — Shows the combination of all defined and undefined channels.

• Active Channels — Shows only the defined channels.

• Inactive Channels — Shows only the channels that are not yet defined.

Channel Number One numeral per row, in the range from 0 (zero) to 99, where any numeral can be the TV 
channel number that you associate with a particular multicast stream. The default behavior 
for this table is that it shows all 100 possible channel numbers, one per row. Your selection 
from the Channel View list might limit how many rows the table contains, and this can 
affect indirectly how many channel numbers you see. If you sort the table by clicking a 
column heading, channel numbers might be rearranged temporarily into an unrecognizable 
sequence. To sort channels back into the expected sequence if their sequence has become 
unrecognizable, click the Channel Number column heading.

Channel Name Blank when the corresponding row describes an undefined TV channel. Otherwise, shows 
a value that you entered or an option that you chose from a list when you defined the 
channel. To understand these values, see Table 3-4 on page 3-15.

Description

Multicast Address: Port

Call Letters for Channel
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Reassign to Nearest Unused 
Channel

Two buttons, either of which can change the association between a channel definition and 
a channel number. The channel definition in the corresponding row becomes associated 
instead with the closest channel (of a higher number or a lower number, respectively) that 
is undefined. These buttons have no effect when every channel is already defined. 

The first row and last row of this table will only ever show one of these buttons apiece. 
These rows differ from all other rows in the table because you cannot use any channel 
number that is lower than the lowest supported channel number or higher than the highest 
supported channel number. The first row shows only , while the last row shows only .

• — Associates the channel definition that the corresponding row describes with 
whichever lower-numbered channel is nearest among the undefined channels. The 
arrow points up because table rows above this row are reserved for lower-numbered 
channels.

• — Associates the channel definition that the corresponding row describes with 
whichever higher-numbered channel is nearest among the undefined channels. The 
arrow points down because table rows above this row are reserved for higher-numbered 
channels.

See Reassigning Channel Numbers, page 3-19.

Actions One of these:

• Set Up Channel — Opens the dialog box where you can enter values and define 
attributes for a TV channel. See Adding New Channels, page 3-15. This button is 
visible only in rows that describe undefined TV channels. 

• — A list from which you can choose one of the following options. This list is visible 
only in rows that describe defined TV channels.

– Edit Channel Settings— Opens the dialog box where you can edit the values and 
attributes of a channel that is already defined. See Editing Channels, page 3-18.

– Reassign to Any Unused Channel — Associates the channel definition that the 
corresponding row describes with whichever channel is nearest among the 
undefined channels. The new channel number might be higher or lower than 
whichever channel number was in effect until you changed it. See Reassigning 
Channel Numbers, page 3-19.

– Delete This Channel— Deletes all entries and attribute values from the definition 
of the channel that the corresponding row describes. The relevant channel number 
will not be associated with any defined channel unless or until you define a new 
channel for it or associate an existing channel with it. See Adding New Channels, 
page 3-15. See also Reassigning Channel Numbers, page 3-19.

Table 3-3 Elements of the TV Channels Table (continued)

Element Description
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Adding New Channels

You can define many attributes for a new TV channel in your lineup. Permitted channel assignments 
range from 1 to 99. 

Step 1 Click the TV Channels tab. To understand elements on this tab, see Understanding the TV Channels 
Table, page 3-13.

Step 2 In the Channel Number column, identify the channel to be defined and, in the corresponding row, click 
Set Up Channel in the Actions column. To understand behaviors of the Set Up Channel button, see the 
“Actions” row in Table 3-4 on page 3-15.

The Add a New Channel dialog box opens.

Step 3 Choose the options or enter the values that meet your requirements, as described in Table 3-4 on 
page 3-15.

Step 4 Do one of the following:

• To save your entries, click Add a Channel. 

• To discard your entries, click Cancel. 

UI Reference: Channel Settings

Table 3-4 Elements for Channel Definitions

Element Description

Your Name for This Channel A meaningful, brief, and unique description of the channel that the corresponding row 
describes, such as China Central Television, Univision, Al-Jazeera, BBC-1, Star Cricket, 
HBO, or CNN.

Address Type The method (multicast or HTTP) that your DMPs will use to receive the video stream for 
this channel. Select an option from the list to enter the correct kind of address. Your 
selection determines which other fields appear on this page. The options are:

• Multicast Address— The routable IP address and UDP port for a streaming server. See 
the “Multicast Address: Port” row, elsewhere in this table.

• HTTP URL— The full HTTP URL for one video file of a supported type. See the 
“HTTP URL” row, elsewhere in this table.

Multicast Address: Port The IP address and port number of the streaming server from which your DMPs will 
receive the multicast stream for this channel. You must specify the port number. This field 
is visible only when you have selected Multicast Address from the Address Type list. (If 
you later select any other option from the Address Type list, DMM-ETV will ignore the 
values in this field.) 

HTTP URL The exact URL and path that points to one MPEG video file on an HTTP server. You must 
use HTTP as the protocol and the filename extension must be MPG. This field is visible 
only when you have selected HTTP URL from the Address Type list.

Text to Show if Program Guide 
is Not Available

Text that describes this channel. The electronic program guide (EPG) shows this text when 
no other information is available. When the EPG uses this text, it does not describe 
individual programs for this channel.
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EPG Provider Associates or disassociates this channel with one EPG data source and specifies the nature 
of that source if you associate one with this channel. You can choose between two source 
types or choose not to use any data source. The options are:

• Tribune Media Services — Before your channel can use any EPG data from TMS, you 
must enter your subscription details and synchronize data on the EPG Providers tab, 
as described in Configuring Subscription Settings for EPG Providers, page 3-20. Then, 
you must configure the channel on the TV Channels tab. For more information about 
these prerequisites, see the “Adding or Editing Subscriptions to Data from an EPG 
Provider” section on page 3-21.

• Upload CSV — It is also possible to have and use an EPG without entering into a 
subscription contract with TMS. Instead, you can create and upload a CSV file that 
contains program descriptions that you have entered. However, to populate your EPG 
completely, you must create and upload a separate CSV file for every channel that your 
EPG should include. (The TMS prerequisites do not apply if your channel will use 
programming data from a CSV file that you upload.) There are strict requirements for 
what constitutes a valid CSV file for this purpose. We strongly recommend that you 
derive your CSV files from the free template that we provide. See the “Download the 
CSV Template” row, elsewhere in this table.

• None — Alternatively, you can choose to disassociate this channel from all EPG data 
sources. In this case, the only information that the EPG will show about this channel 
will be exactly the text that you enter in the Text to Show if Program Guide is Not 
Available field.

Note EPG data is not required for enterprise TV to work. You can enable or disable the 
EPG for Cisco DMS. You are not required to subscribe to any EPG data service. To 
learn how to use enterprise TV without any on-screen program guide, see Using 
‘Skins’ to Customize the Enterprise TV Main Menu, page 3-26.

CSV File (Browse) The method to find and select a CSV file that you have stored locally and will upload to 
your DMM appliance. The file must use syntax and formatting that are perfectly consistent 
with output from the template that we provide for your use. We strongly recommend that 
you derive your CSV files from the template. See the “Download the CSV Template” row, 
elsewhere in this table. This field is visible only when you have selected Upload CSV from 
the EPG Provider list.

Table 3-4 Elements for Channel Definitions (continued)

Element Description
3-16
User Guide for Cisco Digital Media Manager 5.0

OL-15762-01



  

Chapter 3      Managing Digital Signage and Enterprise TV
  Configuring the Settings for an Enterprise TV Network
Download the CSV Template A downloadable template file in Microsoft Excel format that you can use to define the EPG 
attributes for programs on one channel. You can define the attributes for only a few 
programs or for as many as 14 days of programs. You populate fields in the template as 
follows, where each table row contains the attributes for one program in the EPG for the 
corresponding TV channel: 

• Date — The date and time of day when one described program will start. Start times 
for programs in your CSV file must use the format MM/DD/YY HH:mm.

• Duration— The total running time for the described program. Duration values for 
programs must use numerals, which indicate the total duration in minutes.

• Title— The title that the program guide should show for the described program. 
Program titles are limited to a maximum of 23 characters. If the text to be displayed in 
a program title should show any visible quotation marks, you must enter exactly \" for 
each quotation mark that should be visible.

• Description — The actual description that the program guide should show for the 
program. Descriptions are limited to a maximum of 50 characters. If the text to be 
displayed in your program guide should show any visible quotation marks, you must 
enter exactly \" for each quotation mark that should be visible.

After you populate the Microsoft Excel template file with the EPG attributes for programs 
on one channel, save your work as a CSV file that you can upload for use in your EPG.

This link is visible only when you have selected Upload CSV from the EPG Provider list.

Table 3-4 Elements for Channel Definitions (continued)

Element Description
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Editing Channels

Step 1 Click the TV Channels tab. To understand elements on this tab, see Understanding the TV Channels 
Table, page 3-13.

Step 2 In the Channel Number column, identify the channel to be edited; then, click the arrow ( ) in the Actions 
column for that row. 

The Actions menu expands so that you can see and choose among its options.

Step 3 Click Edit Channel Setting.

The Edit an Existing Channel dialog box opens.

Step 4 Choose the options or enter the values that meet your requirements, as described in Table 3-4 on 
page 3-15.

Call Letters for Channel A list of call letters for TV channels that your EPG subscription includes. The list is 
variable according to your location in the United States, the package of channels that you 
receive from your cable or satellite TV provider, the nature of your contract with TMS, and 
possibly other factors. Your list might include some or all of these call letters, possibly 
among others:

• ABC — American Broadcasting Company 

• AZA — Azteca América 

• CBC — Canadian Broadcasting Corporation

• CBS— CBS Broadcasting

• CW— The CW Television Network

• FOX — Fox Broadcasting Company

• MNT— MyNetworkTV 

• NBC — National Broadcasting Company 

• PAX — ION Television 

• PBS— Public Broadcasting Service 

• SRC— SRC 

• TEL — Telemundo 

• TLF— TeleFutura 

• TQS— Télévision Quatre Saisons 

• TVA — Tele Vida Abundante 

• UNI— Univision

This list is visible only when you have selected Tribune Media Services from the EPG 
Provider list.

Table 3-4 Elements for Channel Definitions (continued)

Element Description
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Step 5 Do one of the following:

• To save your entries, click Update Channel. 

• To discard your entries, click Cancel. 

Reassigning Channel Numbers

Step 1 Click the TV Channels tab. To understand elements on this tab, see Understanding the TV Channels 
Table, page 3-13.

Step 2 In the Channel Number column, identify the channel to be edited.

Step 3 To reassign this channel to the nearest unused number, click the up ( ) or down ( ) arrow. To understand 
this method, see the “Reassign to Nearest Unused Channel” row in Table 3-4 on page 3-15.

Alternatively, to specify a number for a channel, do the following:

a. In the Channel Number column, identify the channel to be edited; then, click the arrow ( ) in the 
Actions column for that row.

The Actions menu expands so that you can see and choose among its options.

b. Click Reassign to Any Unused Channel.

c. From the list in the Actions column, choose the channel number to assign to this channel.

Deleting Channels

Step 1 Click the TV Channels tab. To understand elements on this tab, see Understanding the TV Channels 
Table, page 3-13.

Step 2 In the Channel Number column, identify the channel to be deleted; then, click the arrow ( ) in the 
Actions column for that row. 

The Actions menu expands so that you can see and choose among its options.

Step 3 Click Delete This Channel.

The Delete Confirmation dialog box opens.

Step 4 Do one of the following:

• To delete the channel, click Yes. 

• To retain the channel, click No. 

Listing Only the Defined (Active) or Undefined (Inactive) TV Channels

You can filter the TV Channels table so that it describes defined channels only or undefined channels 
only. By default, the table describes all channels.
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Step 1 Click the TV Channels tab. To understand elements on this tab, see Understanding the TV Channels 
Table, page 3-13.

Step 2 From the Channel View list above the column headings, choose one of the following options:

• All Channels (default) — Shows the combination of all defined and undefined channels. 

• Active Channels— Shows only the defined channels.

• Inactive Channels— Shows only the channels that are not yet defined.

Configuring Subscription Settings for EPG Providers
Electronic program guide (EPG) data is not required for enterprise TV to work. You can enable or 
disable the EPG for Cisco DMS. You are not required to subscribe to any EPG data service. 

Note If you want to start a subscription with a commercial provider of EPG data, it is important for you to 
understand that Cisco DMS 5.0.0 and 5.0.1 support only one data format for subscriptions. This 
supported format is available only within the United States and its sole provider is Tribune Media 
Services (TMS) of Chicago, Illinois.

• The TMS product name is TV Schedules, United States. 

• The TMS product scope is Fourteen (14) rolling days.

Other EPG subscription products from TMS use data formats that we do not support in this release. 

If you are already a TMS customer and you have a preexisting subscription contract that authorizes you 
to obtain and use TMS data in the format that this release supports, check with your TMS representative 
whether the terms of your contract authorize you to use TMS data with Cisco Enterprise TV. 

Data from TMS is proprietary, copyrighted, and licensed. Although TMS compiles this licensed data in 
good faith, neither Cisco nor TMS makes any express or implied warranties regarding the data or its 
merchantability or fitness for any particular purpose. 

To learn more about this exact format or to negotiate the commercial contract for a subscription, contact 
Amy Mann, the director of new media sales at Tribune Media Services. Her toll-free telephone number 
is 800 833-9581, ext. 2333, and her email address is aamann@tribune.com. To ensure that your contract 
includes sufficient permissions, be sure to say that you intend to use TMS data for Cisco Enterprise TV.

Tip • You might have to adjust security settings in your network so that you can receive EPG data from 
TMS. The ftp server on your DMM appliance must be able to reach the TMS ftp server. 

• If you want to have and use an EPG without entering into a subscription contract with TMS, you can 
create and upload a CSV file that contains program descriptions that you have entered. See the CSV 
instructions in Adding New Channels, page 3-15.
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This section includes the following topics:

• Adding or Editing Subscriptions to Data from an EPG Provider, page 3-21

• Deleting EPG Data Subscriptions, page 3-22

• Synchronizing TV Channel Schedules and Program Descriptions for the EPG, page 3-22

Adding or Editing Subscriptions to Data from an EPG Provider

You use elements on the EPG Providers page to define the settings for your EPG data subscriptions, view 
a summary of all subscriptions that you have defined and, optionally, choose whether to edit, delete, or 
synchronize a subscription. 

For information about associating a subscription with a channel, see Adding New Channels, page 3-15.

Step 1 Click the EPG Providers tab. 

Step 2 Do one of the following:

• To define the settings for a new subscription, click Add an EPG Provider. 

• To edit a subscription that you defined previously:

a. In the EPG Provider Name column, identify the subscription to be edited; then, click the 
corresponding arrow ( ) in the Actions column.

The Actions menu expands so that you can see and choose among its options.

b. Click Edit.

A dialog box opens, in which you can define or edit the attributes for this subscription. 

Step 3 Choose the options or enter the values that meet your requirements, as described in Table 3-5 on 
page 3-21.

Step 4 Do one of the following:

• To save your entries, do one of the following:

– If you are defining a new subscription, click Add a Provider. 

– If you are editing a subscription that you defined previously, click Update Provider.

• To discard your entries, click Cancel.

UI Reference: EPG Provider Settings

Table 3-5 Elements for Defining EPG Subscription Settings

Element Description

Provider Name The name that you use to distinguish this provider from all other providers. 

Data Format The only supported data format in this release is Tribune Media Services - TV Schedules.

Host or IP Address The routable IP address or DMS-resolvable hostname of the ftp server where you obtain 
EPG data from your subscription provider.

Username Your username to log in to the specified ftp server.

Password The password to authenticate your username to the specified ftp server.
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Deleting EPG Data Subscriptions

You can delete the settings that define your subscription to data from an EPG provider.

Step 1 Click the EPG Providers tab. 

Step 2 In the EPG Provider Name column, identify the subscription to be deleted; then, click the corresponding 
arrow ( ) in the Actions column. 

The Actions menu expands so that you can see and choose among its options.

Step 3 Click Delete.

Step 4 When prompted to confirm your choices, do one of the following:

• To delete the subscription, click Yes. 

• To retain the subscription, click No. 

Synchronizing TV Channel Schedules and Program Descriptions for the EPG

Step 1 Click the EPG Providers tab. 

Step 2 In the EPG Provider Name column, identify the subscription whose TV channel schedules and program 
descriptions should be synchronized to your EPG; then, click the corresponding arrow ( ) in the Actions 
column.

The Actions menu expands so that you can see and choose among its options.

Step 3 Click Synchronize.

The Performing EPG Synchronization dialog box opens. It shows a progress indicator ( ) that spins 
until synchronization has finished. The dialog box then closes itself automatically. 

Step 4 (Optional) To dismiss the dialog box and perform synchronization in the background so that you can 
continue your work, click Run in Background. 

Remote Path The ftp server subdirectory path where EPG data files are stored for your subscription.

Proxy Settings (Optional)

Proxy Hostname The routable IP address or DMS-resolvable hostname and port number of the proxy server 
that your DMM appliance should use if it does not have direct Internet access.Proxy Port

Automatic Synchronization Time

Hour The exact time of day when your DMM appliance should synchronize its program guides 
for enterprise TV with the latest available EPG data from your service provider. Minute

Table 3-5 Elements for Defining EPG Subscription Settings (continued)

Element Description
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Configuring Enterprise TV Settings for Video on Demand

Activation Video-on-demand (VoD) features for enterprise TV depend upon the media library features for digital 
signage. Therefore, even though the DMM-ETV and DMM-DSM software modules are licensed 
separately and can operate independently of one another in most ways, you cannot use VoD features 
for enterprise TV unless you have installed the licenses for both DMM-ETV and DMM-DSM. 

This section contains these topics:

• Working With VoD Categories, page 3-23

• Mapping a Video to a VoD Category, page 3-25

• Organizing Videos in VoD Categories, page 3-25

• Removing a Video from a Category, page 3-26

Working With VoD Categories

Categories help you to manage how VoDs are organized for the interactive main menu at sites where you 
deploy enterprise TV. To learn about adding a VoD to a category, see Mapping a Video to a VoD 
Category, page 3-25.

Step 1 Click the Video on Demand tab. To understand elements on this tab, see VoD Categories, page 3-24.

The Video on Demand listing page opens. The Categories area is on the left, and after you click a 
category, a table on the right describes the videos that are mapped to that category.
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Step 2 To add, modify or delete a category, complete one of the following tasks: 

VoD Categories

To... Do This 

Add a new category 1. Click Categories. 

2. Click Actions > Add a Category. 

3. Enter a descriptive name for the category.

4. Click Save, or click Cancel to discard the entry.

Add a new subcategory 1. Click the category to which you want to add a subcategory. 

2. Click Actions > Add a Category.

3. Enter a descriptive name for the category.

4. Click Save, or click Cancel to discard the entry.

Delete a category 1. Click the name of the category that you want to delete. 

2. Click Actions > Delete Category. 

The Delete Confirmation dialog box opens.

3. Click Yes, or click No to retain the category.

Modify a category 1. Click the name of the category that you want to modify. 

2. Click Actions > Modify Category. 

3. Enter a descriptive name for the category.

4. Click Save, or click Cancel to discard the entry.

Table 3-6 Elements for Managing VoD Categories

Element Description

Categories selector A hierarchical tree (an object selector) of VoD categories. Highlight the name of a 
category to designate it as the one that should contain a VoD that you will map to it.

Actions Options that you can select, whose effect is relative to the category you have selected.

• Create a Category

• Edit Category

• Delete Category

untitled table Each row describes one VoD asset that is mapped to a category for enterprise TV. Asset 
attributes that these columns describe are derived from records in your media library:

• Title

• Description

• Duration

• Source

Map Videos to Category Opens a dialog box in which you can select the videos to be mapped.
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Mapping a Video to a VoD Category

Each video that you map to a category will be listed as a VoD in the interactive main menu at sites where 
you deploy enterprise TV.

Before You Begin

• Add the video to your unified Media Library for digital signage and enterprise TV.

• Create the category. See Working With VoD Categories, page 3-23.

Step 1 Click the Video on Demand tab. 

Step 2 In the Categories area, click the name of the category to which you will add a video. 

Step 3 In the area that lists videos, click Map Videos to Category.

The VoD Mapping dialog box opens. A tree on the left shows the hierarchy of categories for assets in 
your unified Media Library and, after you click a category, an untitled table on the right describes each 
asset in that category.

Step 4 Click the Media Library category that contains the video that you want to use as a VoD.

The videos in this category are described in the untitled table on the right.

Step 5 Click the name of the video, and then drag and drop it to the area below.

Tip To choose more than one video, press the Shift key while clicking the names of videos.

Step 6 Do one of the following:

• To add the video, click Submit Mapping. The category that you chose is now part of the categories 
tree on the Video on Demand page. When you select that category in the tree, the untitled table on 
the left side of the page describes each video that you added as a VoD.

• To discard your entries, click Cancel.

Organizing Videos in VoD Categories

When you organize the videos in a VoD category, you set the order in which Enterprise TV shows the 
videos at your deployment sites.

Step 1 Click the Video on Demand tab. 

Step 2 In the Categories area, click the name of the category that includes the videos to be organized. 

The videos in this category are described in the untitled table on the right.

Step 3 Click the name of the video; then, drag and drop it to its new location in the list. Videos that are higher 
in the list will be shown before videos that are lower in the list.
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Removing a Video from a Category

When you remove a video from a category on the Video on Demand page, you remove it also from the 
interactive main menu at sites where you deploy enterprise TV.

Step 1 Click the Video on Demand tab. 

Step 2 In the area that lists videos, click Map Videos to Category.

The VoD Mapping dialog box opens. A tree on the left shows the hierarchy of categories for assets in 
your unified Media Library and, after you click a category, an untitled table on the right describes each 
asset in that category.

Step 3 Click the Media Library category that contains the VoD to be removed.

The videos in this category are described in the untitled table on the right.

Step 4 Identify the video to be removed from the category.

Step 5 Click the name of the video, and then click Remove.

Step 6 Do one of the following:

• To remove the video, click Submit Mapping.

• To retain the video, click Cancel.

Using ‘Skins’ to Customize the Enterprise TV Main Menu
You can customize the interactive main menu that is presented to viewers at your deployment sites and 
choose which features the menu should include.

Step 1 Click the Skin Customization tab. 

Step 2 To customize the main menu, complete the following tasks, as needed: 

To... Do This

Choose colors for the main menu In the Choose a Skin area, click the radio button for the color scheme that you want.

Specify which features to include In the Features to Include in the Enterprise TV Main Menu area, check the check box 
for each feature that the main menu should include:

• Electronic Programming Guide

• Video on Demand

• Live TV Channels

Display a custom logo 1. In the Upload a Custom Logo area, click Browse. 

2. Select the file to be uploaded, and then click Open. 

3. Click Preview to view the logo file. 

4. Check the Display Custom Logo check box. 

The logo appears in the upper left of the main menu.

Display the Cisco logo Check the Display Cisco Logo check box. 

The logo appears in the lower right of the main menu.
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Step 3 Do one of the following:

• To save this customization without deploying it to any DMPs, click Save. 

• To discard your entries, click Cancel. 

Step 4 To deploy this customized main menu to your DMPs, do the following:

a. Choose Digital Media Players > DMP Manager. See Managing and Grouping Your DMPs, 
page 3-6.

b. Choose the DMP or DMP group that should use this menu skin.

c. Choose ETV-PG from the Actions list, and then click Go.

Working with Assets and Categories in Your Media Library

Activation Software feature modules for Cisco DMS are purchased and licensed separately. Features are hidden 
from all users until you purchase and install the required license to use them, and even then remain 
hidden from users whose privilege levels are low. To understand feature licenses and learn how to install 
them, see Managing Licenses for Features and Components of Cisco DMS, page 2-3. To learn how user 
access to features is restricted by the combination of licenses and user privilege levels, see 
Understanding User Roles in DMS-Admin, page 2-8. To learn which software feature modules are 
available for you to purchase, see http://www.cisco.com/go/dms.

To simplify management, you can organize your assets for digital signage and enterprise TV. We 
recommend that you create categories for sets of characteristics that your assets have in common — such 
as their file type, intended audience, or genre. 

Note This release does not support audio in Shockwave Flash media. If your media library contains any 
Shockwave Flash files that use audio, their playback will be silent on your DMP displays.

Before You Begin

To see and use the Media Library, you must be: 

• Using a DMM appliance on which valid licenses are installed for DMM-DSM and DMM-ETV.

• Logged in as a user with at least read-only permissions for at least one category.

Step 1 Click the Media Library tab.

A tree on the left side of the Media Library page names the types of media that are supported and shows 
the hierarchy of categories that you have created to organize your assets without regard for their media 
type. When you click the name of a media type or of a category, an untitled table on the right side of the 
page is updated automatically to describe assets of the relevant type that your library contains. 
Furthermore, you can filter the untitled table so that it describes only a narrow subset of your assets, 
based on criteria such as the title, file type, or duration.

Step 2 Enter the values and select the options that meet your requirements. To understand the options, see 
Table 3-7 on page 3-28.
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Table 3-7 Elements for Managing Media Files

Element Icon and Description

Media Types A complete list of the types of assets that are supported. The supported assets are:

• DMP Firmware ( )

• HTML ( )

• Images ( )

• Shockwave Flash ( )

• UDP ( )

• Video ( )

When you click the name of a media type, an untitled table on the right side of the page is updated 
automatically to describe assets of the relevant type that your library contains. 

Categories A hierarchical list (an object selector) of all categories in your media library. A category can contain 
assets or it might be empty. You can create new categories, edit existing categories, delete categories, 
or click a category whose assets the untitled table should describe. You can add almost any number 
of nested categories to your media library. 

Options— A menu from which you can choose among these options:

• Create Category — Opens the Add Category dialog box. See UI Reference: {Add | Edit} 
Category Dialog Box, page 3-29.

• Rename Category — Opens the Edit Category dialog box. See UI Reference: {Add | Edit} 
Category Dialog Box, page 3-29.

• Delete Category — Deletes the category that you highlighted.

Create Category — Opens the Add Category dialog box. See UI Reference: {Add | Edit} Category 
Dialog Box, page 3-29.

Filter by Methods by which you can cause the untitled table to describe only the assets from your media library 
that match parameters you have specified. Select the filtering method, specify the parameters, and 
then click Go. You can use only one filter per query. You cannot apply a second filter to results that 
are already filtered. The methods are:

• Title— Enter at least one word that the title contains.

• Filename— Enter a string of characters that the filename contains.

• Description — Enter at least one word that the description contains.

• File Type— Enter the file type to be matched.

• Estimated Duration — Enter in hours, minutes, and seconds, the duration to be matched.

• Date Modified — Click the first calendar icon ( ) to choose the start date for the range of 
modification dates to be matched, then click the second calendar icon to choose the end date for 
the range.

• Owner— Enter the DMM username for the asset owner to be matched.

• Source — Choose whether the asset is stored locally (File) or remotely (URL).

• Path— Enter a string of characters that the path contains.
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UI Reference: {Add | Edit} Category Dialog Box

Make selections and enter required values to add or edit categories in your unified media library for 
digital signage and enterprise TV.

UI Reference: {Add | Edit} Asset Dialog Box

Table 3-9 on page 3-30 describes the dialog box where you add or edit assets in your unified media 
library for digital signage and enterprise TV. Options for this dialog box are sorted under two tabs, Single 
and Batch. To see and use the options on a tab, click its name. 

untitled table Describes all assets contained in the category, or of the media type, that you clicked in the object 
selector. The table sorts information into these columns:

• Asset Title— A unique and human-readable title that you entered.

• Filename— The filename for this asset.

• File Type— Identifies the format of the asset that the corresponding row describes.

• Size — The file size in bytes.

• Estimated Duration — The duration value that you entered when you added this asset to your 
media library, or when you edited attributes of this asset.

• Date Last Modified— Time stamp (in the format DD-MM-YYYY hh:mm:ss) that says when the file 
was last modified.

pagination controls— Buttons and fields clustered under a table, by which you:

• Set how many rows a table should show per page before it starts to span multiple pages.

• Move from one page to another in a table that spans multiple pages.

• Cause the table to show refreshed data.

Options— Choose the option, if any, that meets your requirements:

• Add Media Asset— Opens the Add Asset dialog box. See UI Reference: {Add | Edit} Asset 
Dialog Box, page 3-29.

• View Media Asset— Opens the View Asset dialog box. 

• Edit Media Asset— Opens the Edit Asset dialog box. See UI Reference: {Add | Edit} Asset 
Dialog Box, page 3-29.

• Remove Media Asset— Deletes the asset that you highlighted.

Add Media Asset— Opens the Add Asset dialog box. See UI Reference: {Add | Edit} Asset Dialog 
Box, page 3-29.

Create Playlist — Opens the New Playlist dialog box in a popup window. 

Table 3-7 Elements for Managing Media Files (continued)

Element Icon and Description

Table 3-8

Element Description

Name A unique and human-readable name for a category.

Description A brief description of the category and its purpose.
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The amount of time that a batch download operation requires depends on the speed of your connection, 
the number of directory levels that you search for downloadable files, and the total combined file size of 
all files that you transfer.

Before you add any asset, confirm that its file size is not more than 1.9 GB, which is the maximum stream 
size for any asset that you include in the layout for a DMD presentation. For purposes of stage-one 
failover, the combined size of all assets cannot exceed the capacity of the SD card in a DMP. To 
understand failover, see the “Understanding Content Substitution (Failover)” topic in User Guide for 
Cisco Digital Media Player Device Manager 5.0 on Cisco.com. 

Note • After you start to import an asset, do not click any browser button or navigate away from this page 
until the import is finished. If you do, the import will not finish successfully. 

• We recommend that you do not use your DMM appliance as if it is a storage server. It has limited 
capacity to store files and DMM might not function as designed if space runs low.

Table 3-9 Elements for Adding Assets to the Media Library

Element Description

Single tab

Elements to add or edit one asset. Make selections and enter values to add one asset to your library, and then click Save. 
Alternatively, to discard your selections, click Cancel.

Source The full local pathname or remote HTTP URL of the asset. We do not support any use of spaces in 
filenames or URLs. Do one of the following:

• Click URL, enter the URL, then check or uncheck the Download URL check box to control 
whether you download a local copy of the asset or use the version of it that is stored remotely. 
The URL must be encoded properly (using “%20” instead of spaces, for example), according to 
the principles set forth in RFC 2396.

• Click Local File, then click Browse or enter the full local pathname.
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File Type Select the type that best describes the asset:

• Video — A video file in MPEG-1, MPEG-2, or MPEG-4 format. Our support for MPEG-4 
requires that you use the MPEG-4 Part 2 or Part 10 (H.264) codec and that you multiplex audio 
and video in an MPEG-2 Transport Stream. If your DMP is a 4400G, we support MPEG-4 Part 
10/H.264 video in MPEG-2 TS. (Neither the 4300G nor the 4305G supports MPEG-4 Part 
10/H.264.) The filename extension must be MPG or MPEG and you must enter the estimated 
duration.

• Shockwave Flash — An Adobe Shockwave Flash 6, or 7 file if your DMP is a 4300G or a 4305G. 
Alternatively, if your DMP is a 4400G, then a file in the format of Shockwave Flash 6, 7, 8, or 9. 
The filename extension must be SWF and you must enter the estimated duration. This release 
does not support audio in Shockwave Flash media. If your media library contains any Shockwave 
Flash files that use audio, their playback will be silent on your DMP displays.

• Images— A standard image file, such as a nonprogressive JPEG image. The filename extension 
must be JPG, JPEG, GIF, or PNG.

• HTML— A web page. The filename extension must be HTM or HTML.

• Firmware — A firmware image for the DMP. The filename extension must be FWIMG or BIN. 
See Table 3-19 on page 3-57.

• UDP— The routable IP address and UDP port for a streaming server. 

Title A unique and human-readable name for the asset.

Estimated Duration The estimated duration for playback, counted in hours, minutes, and seconds.

Category Describes each of the categories that should contain this asset. To add a category to the list, click 
Select Category.

Description Optional, brief description of the asset.

Owner Your name or the name of the person who added the asset.

Bulk tab

Elements to add or edit multiple assets simultaneously. Make selections and enter values to add assets to your library, and 
then click Save. Alternatively, to discard your selections, click Cancel. 

Base URL An HTTP URL that points to a directory on a server. The directory that you point to serves as the 
root-level URL for the batch download operation; every file that you download is retrieved from this 
directory or from one of its children at a lower level. We do not support any use of spaces in URLs.

Pattern The filename pattern that identifies which files to download. For example, to download every file that 
uses the three-letter MPG filename extension, the pattern is *.MPG. We do not support any use of 
spaces in filenames.

Note Do not enter the filename pattern to use any unsupported file type. 

Table 3-9 Elements for Adding Assets to the Media Library (continued)

Element Description
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UI Reference: View Asset Dialog Box

Describes the attributes of one asset in your Media Library and, in some cases, shows a preview. 
Attribute information is sorted under two tabs, Overview and Usage. Click a tab to see the asset attributes 
that it describes. To close the View Asset dialog box, click Close.

File Type Select the type that best describes these assets:

• Video — A video file in MPEG-1, MPEG-2, or MPEG-4 format. Our support for MPEG-4 
requires that you use the MPEG-4 Part 2 or Part 10 (H.264) codec and that you multiplex audio 
and video in an MPEG-2 Transport Stream. If your DMP is a 4400G, we support MPEG-4 Part 
10/H.264 video in MPEG-2 TS. (Neither the 4300G nor the 4305G supports MPEG-4 Part 
10/H.264.) The filename extension must be MPG or MPEG and you must enter the estimated 
duration.

• Shockwave Flash — Any Adobe Shockwave Flash 6, or 7 file if your DMP is a 4300G or a 
4305G. Alternatively, if your DMP is a 4400G, then a file in the format of Shockwave Flash 6, 7, 
8, or 9. The filename extension must be SWF and you must enter the estimated duration. This 
release does not support audio in Shockwave Flash media. If your media library contains any 
Shockwave Flash files that use audio, their playback will be silent on your DMP displays.

• Images— Any standard image file, such as a nonprogressive JPEG image. The filename 
extension must be JPG, JPEG, GIF, or PNG.

• HTML— Any web page. The filename extension must be HTM or HTML.

• Firmware — Any firmware image for the DMP. The filename extension must be FWIMG or BIN. 
See Table 3-19 on page 3-57.

• UDP— The routable IP address and UDP port for a streaming server.

Levels The number of levels below the specified base URL to search for (and download) files with filenames 
that match the specified pattern.

Category Click the name of the one category that should contain these assets. 

Table 3-9 Elements for Adding Assets to the Media Library (continued)

Element Description

Table 3-10 Elements for Viewing Asset Attributes

Element Description

Overview tab

Attributes that are derived from information in your media library include the elements with these field labels: Title, 
Description, File Type, Estimated Duration, Owner, Category Names, and Source. To understand these elements, see UI 
Reference: {Add | Edit} Asset Dialog Box, page 3-29. Other elements on the Overview tab are as follows.

Preview Either a generic icon that represents the asset type or a thumbnail that you can click to view this asset, 
assuming that its file type is viewable in your browser.

Path The full HTTP pathname for this asset.

Size The file size.

Playlist Count The total count of playlists that contain and are dependent upon this asset. To learn more about these 
playlists, click the Usage tab.
3-32
User Guide for Cisco Digital Media Manager 5.0

OL-15762-01



  

Chapter 3      Managing Digital Signage and Enterprise TV
  Working with Presentations, Templates, and Presentation Playlists for Digital Signage
Working with Presentations, Templates, and Presentation 
Playlists for Digital Signage

DMM-DSM provides two types of playlists for use in your digital signage network. These two playlist 
types are wholly separate and are not synchronized. The first type is simply called a playlist, while the 
second type is called a presentation playlist. Presentation playlists are reserved for use with your work 
in Digital Media Designer (DMD), and these are the only playlists that DMD recognizes.

Digital Media Designer (DMD) is a powerful, drag-and-drop design tool that helps you to create 
customized presentations for digital signage. Cisco provides predesigned assets that you can use as a 
jumping-off point for your designs or you can create designs that are entirely your own. DMD supports 
horizontal and vertical screen orientations. With DMD, you:

• Subdivide the screen space on a DMP display into rectangular areas called screen zones.

• Select the media objects, called assets, to play back in those screen zones— including media from 
digital video files, JPEG files, SWF files, RSS feeds, ordinary web pages, and other popular 
media types. 

• Add assets to, and configure the timeline for, any screen zone that represents a presentation playlist.

Although you use your browser to start DMD, it runs outside your browser, in Java Web Start. You can 
open and work with only one template or one presentation at a time. Presentations for digital signage 
most commonly divide screen space into two, three, or four screen zones, but you can create more zones 
for a presentation in DMD if you need more. 

After you create, edit, and save a presentation, you can deploy it to your DMPs from the scheduler. Each 
affected DMP then restarts automatically before it starts to show the presentation. To learn how to deploy 
a presentation to your DMPs, see Scheduling Time Slots for Media and Events on DMPs, page 3-73.

This section contains these topics:

• Before You Start to Use Digital Media Designer, page 3-34

• Getting Started with DMD, page 3-35

• DMD User Interface Reference, page 3-37

Presentation Count The total count of presentations that contain and are dependent upon this asset. To learn more about 
these presentations, click the Usage tab.

Date Modified Time stamp (in the format DD-MM-YYYY hh:mm:ss) that says when the file was last modified.

Usage tab

Shows either the Playlists for Asset table or the Presentations for Asset table, depending on whether you click Playlist or 
Presentation, respectively. The table sorts information into the following columns.

Name The name of the presentation or the playlist that is dependent upon this asset.

Time Referenced The total count of instances when the described presentation or playlist includes this asset.

Date Modified Time stamp (in the format DD-MM-YYYY hh:mm:ss) that says when the described presentation or 
playlist was last modified.

Table 3-10 Elements for Viewing Asset Attributes (continued)

Element Description
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• Creating and Organizing Presentation Playlists, page 3-49

• Creating and Organizing Ordinary Playlists, page 3-54

Before You Start to Use Digital Media Designer
Use the following checklist to track your compliance with the requirements and recommended best 
practices for using DMD successfully.

Requirements and Recommendations

Prerequisites

1. Ensure that Java Runtime Engine (JRE) 1.6.0 or later is installed on your PC. Also confirm that it is 
configured to use English as its language, and that it is working correctly. The JRE 1.6.0 release is part of Java 
Version 6. 

• To learn exactly which JRE release you are using and to confirm that it is working correctly, go to 
http://java.com/en/download/help/testvm.xml. 

• To understand the Java release naming conventions, which have changed over time, see 
http://java.sun.com/javase/namechange.html. 

• To obtain the required JRE, go to http://javasoft.com, click Java SE, then download the latest JRE version.

• Apple maintains and distributes its own implementations of Java software for Mac OS users. To learn if Apple 
has made available any JRE that is based on JRE 1.6.0, see http://www.apple.com/java. Alternatively, 
registered Apple Developer Connection (http://connect.apple.com/) members might find that Apple has 
released a preview version of a compatible JRE. We make no claims about the suitability of such software for 
any purpose and recommend that you test all software thoroughly before you rely on it.  

2. If you use Windows, select Start > Settings > Control Panel > Internet Options, then click the Advanced tab. 
Scroll to the Browsing area, deselect the Enable third party browser extensions (requires restart) check box, 
then click OK. 

3. Ensure that your DMPs use firmware version 5.00 or 5.0.1. 

• To check the firmware version on a DMP, log in to its local instance of DMPDM, then click About. 

• If you learn that you must obtain new firmware, log in to your Cisco.com account and then go to 
http://tools.cisco.com/support/downloads/pub/Redirect.x?mdfid=281723656. 

• To learn how to install firmware for a DMP, see the “DMP Firmware Upgrade” row in Table 3-19 on 
page 3-57.

4. You must enable popup windows in your web browser. See the manufacturer documentation for your browser 
and for any installed third-party browser extensions, such as toolbars that provide popup-blocking features.

5. You must already have created and saved the media files that your presentation will show. See Working with 
Assets and Categories in Your Media Library, page 3-27.

6. Confirm that none of the individual assets that you will show has a file size any larger than 1.9 GB. If any file 
has a larger file size, the presentation that should show the file shows nothing and your DMP device logs will 
describe many errors. This size is constrained by the limits of streaming.
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Getting Started with DMD
You can create the layout for a new presentation or edit a presentation that you created previously.

Step 1 To start Digital Media Designer so that you can define a set of screen zones, click the Designs tab, then 
click Start Digital Media Designer.

Step 2 When prompted, select the option to use Java Web Start.

DMD opens. 

In DMD, select the options and enter the values that meet your requirements. To understand the options, 
see DMD User Interface Reference, page 3-37.

Step 3 To save your work in DMD when you are done, select File > Save.

Step 4 To close DMD when you are done, select File > Exit.

Step 5 (Optional) Deploy the presentation to a DMP group. See Scheduling Time Slots for Media and Events 
on DMPs, page 3-73.

7. Make note of the combined file size for the assets in your presentation. If you will use the advanced task called 
“File Transfer to DMP or Server” to deploy your presentation to the SD memory card inside a DMP, confirm that 
the combined file size for all assets that you will show in the presentation is not collectively any larger than:

• For playback on a DMP 4300G— 900 MB.

• For playback on a DMP 4305G— 1.9 GB.

• For playback on a DMP 4400G— 3.8 GB.

This size is constrained by the storage capacity of the SD memory card in a DMP, and might be less than stated 
here if you also have deployed assets for emergency notification. You should consider thoughtfully the storage 
capacity implications on any DMP where you have deployed assets for ordinary events and emergencies.

If you deploy a presentation to the SD memory card, the assets from that presentation will serve as the basis for 
stage-one failover on that DMP. If the combined file size for a presentation is too large, only stage-two failover is 
available. 

To check the free space on the SD memory card in a DMP, log in to its local instance of DMPDM, then click 
Internal Storage. See the “Understanding Content Substitution (Failover)” topic in User Guide for Cisco Digital 
Media Player Device Manager 5.0 on Cisco.com.

Recommended Best Practices

8. Understand the factors that can interfere with smooth playback in streaming media. Playback of media in a 
presentation might be slow or jerky or might fail if:

• You neglect to carefully consider the network bandwidth requirements and DMP memory and CPU 
requirements for the sum total of all assets that you will play simultaneously in a presentation. 

• Your presentation uses too many processor-intensive assets. Remember that some file types (SWF, for 
example) are more likely than others to require extra processing to play back. 

9. Understand the effects on your presentations of the “safe area” on your DMP displays. If you use analog 
DMP displays that are old or inexpensive, be sure that your layouts for signage do not extend past the dotted line 
in DMD that designates the safe area all around the edge of a screen object. The safe area helps you to compensate 
for such displays, which use only approximately 90 percent of their screens. 

Requirements and Recommendations
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Note • To show a presentation during stage-one failovers on a DMP, you must first create and deploy a “File 
Transfer to DMP or Server” task that saves copies of the presentation and its assets to the SD 
memory card inside the DMP. When you do this, DMM-DSM automatically creates a “Go to URL” 
task. The name by default for this generated task is “failover - <name_of_presentation>.” If a DMP 
should show its locally stored presentation at any time other than during stage-one failover, you must 
deploy the corresponding Go to URL task to the DMP. See Scheduling Time Slots for Media and 
Events on DMPs, page 3-73.

• After you delete a presentation for which DMM-DSM automatically generated a corresponding Go 
to URL task, you must also delete that Go to URL task.
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DMD User Interface Reference
Figure 3-1 on page 3-37 shows the Digital Media Designer user interface as it looks when you first open 
it in Java Web Start.

Figure 3-1 Digital Media Designer

In Digital Media Designer, the workspace is the largest part of the user interface. After you enter values 
for it so that it has the same height and width in pixels as the screen on your DMP display, the workspace 
is the canvas where you design your presentations and presentation templates for digital signage.

In addition to its workspace, the user interface in Digital Media Designer consists of four menus, a 
toolbar, and four dockable panels.

• Understanding the Menus and Their Options, page 3-38

• Understanding the Toolbar and Its Options, page 3-41

• Understanding the Panels and Their Options, page 3-42
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Understanding the Menus and Their Options

Table 3-11 on page 3-38 describes the menus in Digital Media Designer.

Table 3-11 Digital Media Designer Menus

Menu Option Description

File Menu

New Shows the New Design/Template dialog box, which lists all of the templates that you have saved as well 
as all of the presentation templates that Cisco provides with DMD, minus any presentation templates that 
you have deleted. Click the template that meets your requirements, such as the template that contains only 
a blank canvas. To start work on your design, click OK. Alternatively, click Cancel to discard your 
selections and return to the canvas.

• {Landscape | Portrait} — Click a tab so that you can select or configure preliminary options for a 
design that will use the corresponding orientation. 

• untitled table— Most rows describe one presentation template apiece that you can use as the basis for 
a new presentation or as the basis for a new presentation template. Alternatively, you can select the 
blank canvas that one row describes. (The blank canvas is described, by default, in the first row.) To 
re-sort the table by the attributes that the Thumbnail, Screen Resolution, Name, or Description columns 
show, click the corresponding column heading. Click a row to select the presentation template or the 
blank canvas that the row describes.

• Filter— Enter any part of a presentation template name to filter out from the table all presentation 
templates whose descriptions do not match your text string. The filtering occurs in real time as you 
enter text.

• Resolution — Enter the resolution width and height in pixels that your presentation design will use. 
This feature is available only when you have selected to use a blank canvas. To learn the native 
resolution for a display, see its manufacturer documentation.

Open Shows the Open dialog box, which lists all of the presentations and presentation templates that you have 
saved, in addition to the presentation templates that Cisco provides with DMD, minus any presentations or 
presentation templates that you have deleted. To open a design so that you can review or change it, select 
it, then click OK. Alternatively, to return to the canvas without opening a design, click Cancel.

• {Presentations | Presentation Templates} — Click a tab to restrict the type of designs that the table 
should describe. 

• untitled table — Each row describes one design. To re-sort the table by the attributes that the 
Thumbnail, Screen Resolution, Name, or Description columns show, click the corresponding column 
heading. Click a row to select the presentation or the presentation template that the row describes.

• Filter— Enter any part of a design name to filter out from the table all of the saved designs whose 
descriptions do not match your text string. The filtering occurs in real time as you enter text.
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Save One of these:

• If you are designing a layout that you have not yet saved and named, opens the Save Presentation dialog 
box. Select the options and enter or confirm the values that meet your requirements:

– Name— A unique and human-readable name for the layout. The name is unique in the sense that 
you have not used it previously as the name for anything that can be scheduled.

– Description — A brief description of the layout and its purpose.

– Resolution— Shows in pixels the width and height that your design will require as a supported 
resolution on your DMP display. Uses this syntax: NNNNxNNN. For example, 1366x768 would 
specify a display that can show as many as 1,366 pixels horizontally and as many as 768 pixels 
vertically. Confirm that the values you see are not any greater than what your DMP display can 
actually show.

– Presentation— Identifies the layout as a one-time design. A presentation is a design that uses a 
freeform layout or uses a layout derived from a presentation template.

– Presentation Template— Identifies the layout as a foundational design. A presentation template 
is the basis, potentially, for multiple presentations that you expect to create in the future, which all 
will share a common look and feel.

When you are done, click OK to save your work or click Cancel to discard your work.

• If you are working on a layout that you saved previously, saves your work since then.

Save As Opens the “Save As Presentation or Presentation Template” dialog box, so that you can save multiple 
variants of a presentation or a template, or so you can overwrite a saved presentation or saved presentation 
template that you no longer need. Select the options and enter or confirm the values that meet your 
requirements: 

• {Presentations | Presentation Templates} tab — Determines whether the table under the tab shows 
information about your saved presentations or about your saved presentation templates. Each row in 
the table shows a thumbnail picture of the corresponding design and describes its attributes.

• Name— A unique and human-readable name for the design. The name is unique in the sense that you 
have not used it previously as the name for anything that can be scheduled.

• Description — A brief description of the design and its purpose.

• {Resolution | Screen Resolution}— Shows in pixels the width and height that your design will require 
as a supported resolution on your DMP display. Uses this syntax: NNNNxNNN. For example, 
1366x768 would specify a display that can show as many as 1,366 pixels horizontally and as many as 
768 pixels vertically. Confirm that the values you see are not any greater than what your DMP display 
can actually show.

• Presentation— Select this radio button to identify the layout as a one-time design that uses a freeform 
layout or a layout that you will derive from a presentation template.

• Presentation Template — Select this radio button to identify the layout as a foundational design. A 
presentation template is the basis, potentially, for multiple presentations that you expect to create in 
the future, which all will share a common look and feel.

When you are done, click Save to save your work or click Close to discard your work.

Table 3-11 Digital Media Designer Menus (continued)

Menu Option Description
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Delete 
Presentation/
Template

Shows the Delete Presentation(s) and/or Presentation Template(s) dialog box, which lists all of the 
presentations and presentation templates that you have saved, in addition to the presentation templates that 
Cisco provides with DMD, minus any presentations or presentation templates that you have already 
deleted. 

• {Presentations | Presentation Templates} — Click a tab to restrict the type of designs that the table 
should describe. 

• untitled table — Each row describes one design. To re-sort the table by the attributes that the 
Thumbnail, Screen Resolution, Name, or Description columns show, click the corresponding column 
heading. Click a row to select the presentation or the presentation template that the row describes.

• Filter— Enter any part of a design name to filter out from the table all of the saved designs whose 
descriptions do not match your text string. The filtering occurs in real time as you enter text.

To delete a design, select it, and then click Delete Selected Presentation. To return to the canvas whether 
or not you have deleted any designs, click Close.

Exit Closes DMD.

Edit Menu

Whole Screen Expands the selected object so that its height and width become the same as the total height and width of 
your layout. To reduce its dimensions again if you prefer to use smaller dimensions, edit the height and 
width values that the Properties panel shows for the selected object. This feature is not available for you to 
use unless at least one object is selected on the workspace or in the Layouts panel.

Safe Area Expands the selected object so that its height and width become the same as the height and width of the 
safe area in your layout. To change its dimensions again, edit the height and width values that the Properties 
panel shows for the selected object. This feature is not available for you to use unless at least one object is 
selected on the workspace or in the Layouts panel.

Delete Deletes the selected object or action from the workspace. This feature is not available for you to use unless 
at least one object or action is selected on the workspace or in the Layouts panel.

Up Moves the selected object up by one layer, in the sense that your layout might position overlapping screen 
zones as if they are stacked or piled on top of each other. When you use this option, you make the selected 
screen zone more prominent than it was before you moved it. This feature is not available for you to use 
unless at least one object is selected on the workspace or in the Layouts panel.

Down Moves the selected object down by one layer. When you use this option, you make the selected screen zone 
less prominent than it was before you moved it. This feature is not available for you to use unless at least 
one object is selected on the workspace or in the Layouts panel.

Top Moves the selected object to the top layer. When you use this option, the effect is that you make the selected 
screen zone more prominent than every other screen zone. This feature is not available for you to use unless 
at least one object is selected on the workspace or in the Layouts panel.

Bottom Moves the selected object to the bottom layer. When you use this option, the effect is that you make the 
selected screen zone least prominent of all your screen zones. This feature is not available for you to use 
unless at least one object is selected on the workspace. or in the Layouts panel

Table 3-11 Digital Media Designer Menus (continued)

Menu Option Description
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Understanding the Toolbar and Its Options

The toolbar in DMD contains buttons that you click and controls for the degree of workspace 
magnification. To understand the toolbar, see Table 3-12.

View Menu

{Objects/
Actions | Layers 
| Navigator | 
Properties}

Expands or collapses the respective panel. To understand the panels, see Understanding the Panels and 
Their Options, page 3-42.

Tools Menu

Add Action > As described in the “Understanding the Objects/Actions Panel and Its Options” section of Table 3-13 on 
page 3-43:

• {Static | RSS} Text Ticker

• Synchronize Playlists

Add Object > As described in the “Understanding the Objects/Actions Panel and Its Options” section of Table 3-13 on 
page 3-43:

• Screen

• Box

• Video Playlist

• Nonvideo Playlist

Table 3-11 Digital Media Designer Menus (continued)

Menu Option Description

Table 3-12 Digital Media Designer Toolbar

Icon Tool Name Description

Save 
Changes

Saves your work.

Delete 
Selected 
Object

Deletes from your design the one object or action that is selected on the workspace.

Zoom In Increases the degree of magnification by 10 percentage points per click.

Incremental 
Zoom

Increases or decreases the degree of magnification by 1 percentage point per click, depending 
respectively on whether you click the arrow head that points up or the arrow head that points down. 
Alternatively, you can do either or both of the following:

• Use the scroll wheel on your mouse to increase or decrease the degree of magnification.

• Enter any percentage value in the unlabeled field, then press Enter.

Zoom Out Decreases the degree of magnification by 10 percentage points per click.

View 
Workspace

Increases or decreases the degree of magnification by whatever percentage amount is necessary to fit 
the entire screen object inside the visible workspace.
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Understanding the Panels and Their Options

Panels are dockable controls in the Digital Media Designer user interface that you can move, resize, 
expand, or collapse, which contain features to help you design layouts for digital signage. All panels are 
opened by default. To understand how to use the features of a particular panel, see:

• Understanding the Objects/Actions Panel and Its Options, page 3-43

• Understanding the Layers Panel and Its Options, page 3-47

• Understanding the Navigator Panel and Its Options, page 3-48

• Understanding the Properties Panel and Its Options, page 3-48

Moving Panels To move a panel so that its location is more convenient to you, drag it by its title bar to the location that 
you prefer. The only constraint when you move a panel is that one side of it will always be pinned to 
the workspace. DMD rearranges and resizes the other panels automatically to create an open space for 
the panel that you are moving.

Resizing Panels To change the width or height of a panel, click and drag the vertical or the horizontal border between 
it and the workspace. The width or height of nearby panels changes automatically in response.

Collapsing and 
Expanding Panels

• To collapse a panel, click the square button at the right end of its title bar. In its collapsed form, 
the entirety of a panel is reduced to button form, where the button shows nothing except the panel 
name in very small type and is pinned to one edge of the DMD window. 

• To reopen a panel temporarily after you collapse it, click where you see its name pinned to the edge 
of the DMD window. After you move your mouse away from the panel, it closes again 
automatically.

• To reopen a panel that you collapsed, click where you see its name pinned to the edge of the DMD 
window, then click the square button at the right end of its title bar. 
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Understanding the Objects/Actions Panel and Its Options

An action is a behavior that you can add to an object in your layout. Each object occupies a layer.

Table 3-13 Digital Media Designer — The Objects/Actions Panel

Icon Tool Name Description

Box Creates a new screen zone and a new layer where you can show:

• One bitmapped image in JPEG, GIF, or PNG format. (Other file types are not supported.) If you 
place a bitmapped image in a box object, be sure that the box object uses the same height and width 
in pixels that the bitmapped file uses. If the box object is too small, the displayed image will be 
cropped. It will not be resized or scaled automatically.

• One text string. The string can be completely motionless and presented without any visual effects 
when you show it on a DMP display or you can show it in the form of a ticker.)

• One background color.

To start using a box object, drag it to the workspace from the Objects/Actions panel or select Tools > 
Add Object > Box. To populate and configure a box object, click it on the workspace, then make 
selections and enter values in the Properties panel. To understand the Properties panel, see 
Understanding the Properties Panel and Its Options, page 3-48.

When you choose which layer to use for a box object in your layout, ensure that you choose a layer that 
is lower than any layer that your playlist objects use in the same layout. Otherwise, your DMP displays 
will not show the screen zone that the box object represents. To understand the use of layers in DMD, 
see Understanding the Layers Panel and Its Options, page 3-47. 

If you right-click a box object after it is part of your layout, a shortcut menu appears. To understand its 
options, see the “Edit Menu” section in Table 3-11 on page 3-38.

Note The Properties panel values that you see might be misleading for a box object after you select it 
on the workspace, if you have associated it with a ticker action. Furthermore, box object 
attributes that you see in the Properties panel can differ according to the type of ticker action 
that you use. If you use a static ticker, there are two possible scenarios. In the first scenario, you 
enter Properties panel text for the box object but not for the ticker action, so the ticker shows the 
text that you entered for the box object because it has no alternative. In the second scenario, you 
enter Properties panel text separately for both the box object and the ticker action, and the ticker 
ignores the text that you entered for the box object because instead, it shows the text that you 
entered for the ticker action. In that case, even though you can see in the Properties panel that 
you entered text for your box object, DMD ignores that text. There is only one relevant scenario 
if you use an RSS ticker, assuming that the server for your RSS feed is reachable and configured 
correctly. The RSS ticker always shows what it receives from the RSS server, without regard for 
any text that you might have entered in the Properties panel after you selected your box object 
on the workspace or in the Layouts panel. Even though you can see in the Properties panel that 
you entered text for your box object, DMD ignores that text.
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Nonvideo 
Playlist

Creates a new screen zone and a new layer where you can arrange and play back in any combination an 
ordered sequence of JPEG, GIF, and PNG files, SWF files, and pages on web servers. If you place a 
bitmapped image in a playlist object, be sure that the playlist object uses the same height and width in 
pixels that the bitmapped file uses. If the playlist object is too small, the displayed image will be 
cropped. It will not be resized or scaled automatically.  

To start using a nonvideo playlist object, drag it to the workspace from the Objects/Actions panel or 
select Tools > Add Object > Nonvideo Playlist. A layout can contain any number of nonvideo playlist 
objects at a time. 

To populate and configure the object, click it on the workspace or in the Layouts panel, then make 
selections in the Properties panel. For example, the Properties panel is where you define the playback 
sequence for a playlist and define the playback duration for each entry that it contains. To understand 
the Properties panel, see Understanding the Properties Panel and Its Options, page 3-48. 

You can place this object on any layer in your layout. To understand layers in Digital Media Designer, 
see Understanding the Layers Panel and Its Options, page 3-47. 

If you right-click a playlist object after it is part of your layout, a shortcut menu appears. To understand 
its options, see the “Edit Menu” section in Table 3-11 on page 3-38.

Note The Properties panel values that you see for a selected playlist object might be misleading if you 
have used a synchronize playlists action to override the natural timing of transitions between 
assets in the playlist. See the “Synchronize Playlists” row elsewhere in this table.

Table 3-13 Digital Media Designer — The Objects/Actions Panel (continued)

Icon Tool Name Description
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Video 
Playlist

Creates a new screen zone and a new layer where you can arrange and play back in any combination 
an ordered sequence of video files (MPEG-1 and MPEG-2 files for all DMP model types and MPEG-4 
part 10 H.264 files on the DMP 4400G model exclusively), SWF files, JPEG, GIF, and PNG files, 
multicast video streams, and pages on web servers. 

Tip When you use a video playlist object, it becomes the topmost layer automatically in your 
presentation. Other object types (nonvideo playlist objects and box objects) are rendered in back 
of the video playlist object, which means that you cannot use them to create an overlay or mask 
for video. To use an overlay of that kind, we recommend that you encode the video file itself so 
that it includes an overlay before you add it to your media library. Alternatively, you can use 
JavaScript to create a presentation outside of DMD. 

If you place a bitmapped image in a playlist object, be sure that the playlist object uses the same height 
and width in pixels that the bitmapped file uses. If the playlist object is too small, the displayed image 
will be cropped. It will not be resized or scaled automatically.

To start using a video playlist object, drag it to the workspace from the Objects/Actions panel or select 
Tools > Add Object > Video Playlist. A layout cannot contain any more than one video playlist object 
at a time. 

To populate and configure the object, click it on the workspace, then make selections in the Properties 
panel. For example, the Properties panel is where you define the playback sequence for a playlist and 
define the playback duration for each entry that it contains. To understand the Properties panel, see 
Understanding the Properties Panel and Its Options, page 3-48. 

You can place this object on any layer in your layout. To understand layers in Digital Media Designer, 
see Understanding the Layers Panel and Its Options, page 3-47. 

If you right-click a playlist object on the workspace, a shortcut menu appears. To understand its options, 
see the “Edit Menu” section in Table 3-11 on page 3-38.

Note The Properties panel values that you see might be misleading for a playlist object after you select 
it on the workspace, if you have used a synchronize playlists action to override the natural timing 
of transitions between assets in the playlist. See the “Synchronize Playlists” row elsewhere in 
this table.

New Screen Restarts your design process by closing the open layout — discarding any design work in it that you have 
not saved— and showing to you a completely new representation of a blank DMP display as 
your workspace. Because each presentation and each presentation template can contain only one screen, 
the new workspace does not have any objects, actions, or playlists associated with it— even if the closed 
layout used them.

To start using a new screen, drag it to the workspace from the Objects/Actions panel or select Tools > 
Add Object > Screen. DMD asks you if you really want to proceed. By proceeding, you will discard 
any unsaved work in the layout that you close. 

Table 3-13 Digital Media Designer — The Objects/Actions Panel (continued)

Icon Tool Name Description
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Static Text 
Ticker

Places a static ticker action on your workspace. Its size and placement on the workspace do not matter 
because actions do not, by themselves, occupy any space on a screen. 

A ticker action will not produce a visible ticker on your DMP displays until you finish configuring the 
association between the action and the object, save your work, and deliver your presentation to a DMP 
as part of a scheduled deployment. You can use only one ticker per box object. 

The workflow for this action is as follows:

1. To add the potential for a static text ticker to your layout, drag its action type to the workspace from 
the Objects/Actions panel or select its type from the Tools menu. 

2. Select the action on your workspace.

3. In the Properties panel:

a. Enter text for your ticker in the Text field.

b. From the Assign to Object list, select the box object that should contain the ticker. 

RSS Text 
Ticker

Places an RSS ticker action on your workspace. Its size and placement on the workspace do not matter 
because actions do not, by themselves, occupy any space on a screen. 

A ticker action will not produce a visible ticker on your DMP displays until you finish configuring the 
association between the action and the object, save your work, and deliver your presentation to DMPs 
as part of a scheduled deployment. Your DMPs will check the RSS feed and update the ticker every 
15 minutes. You can use only one ticker per box object. 

The workflow for this action is as follows:

1. To add the potential for an RSS ticker to your layout, drag its action type to the workspace from the 
Objects/Actions panel or select its type from the Tools menu. 

2. Select the action on your workspace.

3. In the Properties panel:

a. Enter the RSS feed source URL for your ticker in the RSS URL field. 

The feed that you specify should be one that does not include any file enclosures. We 
recommend as a best practice that you use only RSS feeds over which you have direct editorial 
control.

b. From the Assign to Object list, select the box object that should contain the ticker. 

Table 3-13 Digital Media Designer — The Objects/Actions Panel (continued)

Icon Tool Name Description
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Understanding the Layers Panel and Its Options

The Layers panel lists all of the objects that you have dragged to your workspace, sorted by their 
placement on different layers. Each layer holds one object only, and each object represents one 
screen zone. 

• The object at the bottom of the list is also the screen zone that is behind or under all of your other 
screen zones in this layout. 

• The object at the top of the list is also the screen zone that is in front of or on top of all of your other 
screen zones in this layout. 

• If you select an object in the list, you can use buttons in the Properties panel to manipulate the 
selected object.

Synchronize 
Playlists

Places a synchronization action on your workspace. Its size and placement on the workspace do not 
matter because actions do not, by themselves, occupy any space on a screen. 

You use a synchronization action to bind two playlist objects together in a layout, imposing the playback 
timing from the primary playlist on, and overriding, the playback timing for the secondary playlist. In 
this way, you can synchronize transitions in two playlists, no matter how asynchronous those transitions 
would be ordinarily. The workflow is as follows:

1. To add the potential for synchronization to your layout, drag a Synchronize Playlists action to 
the workspace from the Objects/Actions panel or select Tools > Add Action > 
Synchronize Playlists. 

2. In the Properties panel:

a. From the Primary Playlist list, select the primary playlist object.

b. From the Secondary Playlist list, select the secondary playlist object.

Note If you plan ahead, you can keep in mind the eventual synchronization of two playlists when you 
populate them and configure the playback duration for each asset. If you do not plan ahead, 
synchronization might truncate the playback for one or more assets in the secondary playlist.

Table 3-13 Digital Media Designer — The Objects/Actions Panel (continued)

Icon Tool Name Description

Table 3-14 Digital Media Designer — The Layers Panel

Icon Tool Name Description

Remove Deletes the selected object.

Bring to 
Front

Moves the selected object to the absolute top layer.

Move Up Moves the selected object up by one layer per click.

Move Down Moves the selected object down by one layer per click.

Send to Back Moves the selected object to the absolute bottom layer.
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Understanding the Navigator Panel and Its Options

The Navigator panel shows a wireframe thumbnail view of, and scrolling controller for, your workspace 
in DMD. The Navigator panel is especially useful when you design presentations for high-definition 
DMP displays, because you might not be able to see the entire design all at one time in the workspace 
area.

To scroll the workspace vertically and horizontally, click and move the small gray rectangle from place 
to place inside the Navigator panel.

Understanding the Properties Panel and Its Options

Shows the editable and uneditable properties of the selected object or action. The type of properties that 
you see depend on the type of object or action that you select on the workspace or in the Layouts panel. 

Table 3-15 Digital Media Designer — The Properties Panel

Element Icon and Description

Border 
{Style | Width | 
Color}

Make selections to define the border attributes, if your box object should be enclosed in a border.

Assign to Object Select the box object that represents the screen zone where the selected ticker action should show 
its ticker.

Duration Shows the playback duration for each asset in the selected playlist. If you use the Synchronize Playlists 
action to make the selected playlist secondary, the duration values shown here might not have any 
bearing on how long an asset plays back before the playlist transitions to the next asset. There is no 
factory default duration value for nonvideo assets, so you must enter all such duration values manually.

Type Signifies the type of playlist. This value is not editable.

Name An editable field or an uneditable column in a table:

• Enter a unique and meaningful name in the Name field to identify the selected object or action. 

• Click the Name column heading to sort the table by the values in that column.

Playlist Items To understand the elements in the Playlist Items area, see Understanding the Playlist Items Area and 
Its Options, page 3-51. 

To learn about the workflow to create a playlist, see Creating and Organizing Presentation Playlists, 
page 3-49.

Primary Playlist Select the playlist object whose transition timing between assets during playback should override the 
equivalent transition timing of a secondary playlist.

RSS URL Enter the source URL for the RSS feed.

Effect Choose whether the ticker should fade or scroll and, for scrolling, choose the direction of motion. For 
a DMP 4300G or 4305G, only the fading effect is supported. For a DMP 4400G, all effects are 
supported.

Secondary Playlist Select the playlist object whose transition timing between assets during playback should be overridden 
by the equivalent transition timing from the primary playlist.
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Creating and Organizing Presentation Playlists
Presentations that you design in DMD can contain playlists that you configure. A presentation playlist 
contains assets from one or more media library categories or remote servers and shows these assets in 
the sequence that you specify. The only way to save a presentation playlist and deploy it to your DMPs 
is inside a presentation. 

Caution Important considerations apply to your presentation playlists when you use ACNS. Before you delete a 
channel from ACNS, you must first remove from the shared schedule for DMM-DSM and DMM-ETV 
every presentation playlist that calls upon the channel. Then, you must edit all affected presentation 
playlists so that they do not use the channel. Otherwise, if a presentation playlist is scheduled for 
deployment but you delete an ACNS channel that it uses for content distribution, you will be prevented 
from deleting the playlist manually even though your DMPs cannot obtain its assets successfully from 
the deleted channel. 

Before You Begin

• You must add assets to your media library before you can organize them in a playlist. See the “UI 
Reference: {Add | Edit} Asset Dialog Box” row in Table 3-7 on page 3-28.

• You must add a DMP to DMM-DSM before you can deploy any presentations to it, and you must 
organize your DMPs into groups before you can deploy any presentation to a group. The DMP 
Groups list does not show any DMPs until you add at least one. See Managing and Grouping Your 
DMPs, page 3-6.

• You must add an external deployment server to DMM-DSM before you can deploy any presentations 
to it. The DMP Groups list does not show any external servers until you add at least one. You cannot 
use the Schedules > Immediate Deployment feature with external deployment servers. All 
deployments to your external deployment servers require that you use the Schedules > Play in Future 
feature. See Configuring DMM-DSM to Deploy to External Servers, page 3-88.

Text {Size | Color | 
Horizontal 
Alignment | Vertical 
Alignment | Text}

All of the following:

• Increases or decreases the text size (in pixels), depending respectively on whether you click the 
arrow head that points up or the arrow head that points down. 

• Changes the text size (in pixels) to the numeric value that you enter. 

• Changes the text color to match a color that you select after you click ... or to match a hexidecimal 
color value that you enter.1 

• Changes the horizontal or vertical alignment of text to match the alignment types that you select. 

• Shows exactly the text that you enter in the Text field.

URL An uneditable column in a table, where each row shows the URL for one remote playlist asset.

{Width | Height} Enter in pixels the respective width and height of the selected screen zone object.

{X | Y} X and Y coordinates that represent the placement of the first pixel (when reading from left to right and 
top to bottom) of the selected object.

1. The text color that you use should be one that results in clear and legible text against the background color that you specified; if there is not enough 
difference between the two colors, your audience might not see information clearly when you use this layout to show text on a DMP display.

Table 3-15 Digital Media Designer — The Properties Panel (continued)
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Tip We recommend that you use the advanced task called DMP Startup URL and enter a value for either the 
Video URL or the Browser URL. If both values are blank, you might find that your DMP sometimes 
loses its ability to play even the Shockwave Flash files that it has played successfully in the past. To learn 
how to use advanced tasks, see Using Advanced Tasks, page 3-56. To understand this advanced task, see 
the “DMP Startup URL” row in Table 3-19 on page 3-57. 

Step 1 In DMD, do any of the following:

• Drag a playlist object (video or nonvideo) to the workspace from the Objects/Actions panel.

• Click a playlist object that you already placed on your workspace.

• Click a playlist object in the Layers panel.

The Properties panel now contains an area called “Playlist Items,” where you can make selections that 
add, remove, or rearrange assets in a presentation playlist. To understand how presentation playlists for 
DMD differ from other playlists in DMM-DSM, see Working with Presentations, Templates, and 
Presentation Playlists for Digital Signage, page 3-33.

Step 2 In the Playlist Items area, enter values and select options that meet your requirements. To understand the 
Playlist Items area, see Table 3-16 on page 3-51.

Step 3 To open the Content Chooser dialog box, where you configure a presentation playlist, click . To 
understand the Content Chooser dialog box, see Table 3-17 on page 3-53.

Step 4 To save a presentation playlist after you have populated and organized it and set the playback duration 
for each of its assets, click Submit in the Content Chooser dialog box.

Step 5 To save a presentation or a template after you have finished designing it, select File > Save in DMD. To 
understand the dialog box for saving your designs, see the “File Menu” section of Table 3-11 on 
page 3-38.

Step 6 Deploy the presentation to the DMP displays that should show it. See Scheduling Time Slots for Media 
and Events on DMPs, page 3-73.
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Understanding the Playlist Items Area and Its Options

The Playlist Items area loads inside the Properties panel when the selected object on your workspace is 
either a video playlist object or a nonvideo playlist object. 

• To understand these two object types for presentation playlists, see Table 3-13 on page 3-43. 

• To understand other elements inside the Properties panel, see Understanding the Properties Panel 
and Its Options, page 3-48.

Table 3-16 Elements for Managing Presentation Playlists

Element Icon and Description

unlabeled check box Click to select (or to deselect) one or more assets so that you can change the playback sequence of, 
or remove assets from, the playlist that you are editing.

asset location Shows a miniature icon to indicate whether you selected the asset from your media library or from a 
remote server.

media library

remote server

IANA Internet 
media type

Shows a miniature file icon to represent the asset that the corresponding row describes. DMD 
identifies assets according to their IANA-registered Internet media types. To learn about media types 
and understand the requirements to register them, see http://www.iana.org/assignments/media-types/.

Video asset of any supported type, whether a file or a multicast stream.

Shockwave Flash 6 or 7 asset, if your DMP is a 4300G or a 4305G. Alternatively, a Shockwave 
Flash 6, 7, 8, or 9 asset, if your DMP is a 4400G.

JPEG, GIF, or PNG asset.

Web page.

Name A unique and human-readable name that you entered.

Duration, sec The playback duration in seconds for the asset that the corresponding row describes. Click a value to 
see and use its duration control ( ), which is hidden until you click the value. To increase the 
playback duration by 1 second, click the top of a control. Alternatively, to reduce the playback 
duration by 1 second, click the bottom of a control. To increment or decrement the duration value 
quickly, hold down the mouse button after you click the top or the bottom of a control.

URL Shows the storage URL for the asset that the corresponding row describes.

Add Opens the Content Chooser dialog box, where— to populate a playlist — you make selections 
from your media library or enter the URLs for remotely stored assets. To understand the 
Content Chooser dialog box, see Table 3-17 on page 3-53.

Remove Removes all of the selected assets from the relevant playlist. Nonetheless, the assets remain in 
your media library or on the remote server from which you selected them.

Move Up Reorders the playlist so that the selected asset moves up one row, exchanging places with the 
asset that was above it.

Move Down Reorders the playlist so that the selected asset moves down one row, exchanging places with 
the asset that was below it.
3-51
User Guide for Cisco Digital Media Manager 5.0

OL-15762-01

http://www.iana.org/assignments/media-types/


  

Chapter 3      Managing Digital Signage and Enterprise TV
  Working with Presentations, Templates, and Presentation Playlists for Digital Signage
Understanding the Content Chooser and Its Options

The Content Chooser dialog box is part of DMD. You use the Content Chooser to populate a presentation 
playlist. To save your work and use a presentation playlist that you have populated, click Submit. 
Alternatively, to discard your work, click Cancel. 

Tip We recommend that you use the advanced task called DMP Startup URL and enter a value for either the 
Video URL or the Browser URL. If both values are blank, you might find that your DMP sometimes 
loses its ability to play even the Shockwave Flash files that it has played successfully in the past. To learn 
how to use advanced tasks, see Using Advanced Tasks, page 3-56. To understand this advanced task, see 
the “DMP Startup URL” row in Table 3-19 on page 3-57. 
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UI Reference: The Content Chooser

Table 3-17 on page 3-53 describes elements in the Content Chooser dialog box.

Table 3-17 Elements to Manage Assets in Playlists

Element Icon and Description

{Content Manager | 
URL}

Tabs that you can select, which determine whether the Available Content table will show selectable 
assets in your media library or help you to select an asset that is stored remotely. 

Content Groups An object selector that lists all of the categories in your media library and that is visible only when 
the Content Manager tab is selected. From the object selector, click the one category that the 
Available Content table should describe. See Working with Assets and Categories in Your Media 
Library, page 3-27. 

Available Content A table, which describes every available asset in the category that you clicked. Click any other 
category to see descriptions of its assets in the Available Content table. 

Add to Playlist — Adds to the Selected Items table whichever assets you have checked in the 
Available Content table, so that they might be included in a playlist. To add more assets to the 
Selected Items table, repeat this step as many times as necessary.

— Name— The name that you entered for the asset.

— Type— Says whether the asset is stored locally or should be retrieved from an HTTP URL.

— Path— Shows the HTTP URL for the described asset.

External URL Area where you select an asset that is stored remotely, so that you can add the asset to the Selected 
Items table.

— Name— Enter a name to describe the asset.

— URL — Enter the HTTP URL for the remote asset, or enter the UDP URL and port number.

Add URL — Add the remote asset to the Selected Items table, so you can might include it in 
a playlist.
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Creating and Organizing Ordinary Playlists

Note • Playlists that you create under the Digital Signage tab are separate from and mutually exclusive from 
the presentation playlists that you create in DMD. To assign a playlist to a zone for a presentation, 
you must use a presentation playlist, which you used DMD to create.

• You cannot add an advanced task (or a system task) to a playlist. However, you can schedule 
advanced tasks to occur between playlists.

Step 1 Choose Digital Signage > Playlists.

Step 2 Select the options and enter the values that meet your requirements. 

Selected Items A table, which describes every asset that you have selected so far for the playlist that you are 
configuring. Sorts the assets according to their order of playback. Also, includes features to change 
the playback order, change the duration of playback for each asset, and remove assets from 
the playlist.

Move Down— Changes the order of playback for assets in your playlist. Reorders the list so 
that the one asset whose name you have highlighted moves down by one row, exchanging places 
with the asset that was below it.

Move Up— Changes the order of playback for assets in your playlist. Reorders the list so that 
the one asset whose name you have highlighted moves up by one row, exchanging places with 
the asset that was above it.

Remove Assets from Playlist— Removes any number of assets from the playlist that you are 
configuring. You must first select one or more check boxes, corresponding to the assets that 
you want to remove. Even though you remove these assets from the playlist, they remain 
available in your media library or on the remote server that you specified.

— Name— The name that you entered for the asset.

— Duration, sec — The number of seconds that the asset will be visible when you show it on a 
DMP display. Click a value to see and use its duration control ( ), which is hidden until you 
click the value. To increase the playback duration by 1 second, click the top of a control. 
Alternatively, to reduce the playback duration by 1 second, click the bottom of a control. To 
increment or decrement the duration value quickly, hold down the mouse button after you click 
the top or the bottom of a control. 

• If you do not specify a duration for playback of video and SWF assets, the file plays 
to completion one time. 

• If you do not specify a duration for playback of images or web pages, their duration 
is continuous.

— URL — Shows the HTTP URL for the described asset. 

Table 3-17 Elements to Manage Assets in Playlists (continued)

Element Icon and Description
3-54
User Guide for Cisco Digital Media Manager 5.0

OL-15762-01



  

Chapter 3      Managing Digital Signage and Enterprise TV
  Working with Presentations, Templates, and Presentation Playlists for Digital Signage
If you do not understand your options, see Table 3-18 on page 3-55. When you make selections 
anywhere on the Playlists page, it is updated automatically to show the options and features that are 
relevant to your selection. 

UI Reference: New Playlist Dialog Box

Table 3-18 Elements to Define an Ordinary Playlist

Element Description

Title The title for this playlist.

Assets A table in which each row describes one asset. Attributes are sorted into these columns:

• Title— A unique and human-readable name for the asset.

• File Type— the type that best describes the asset: Video, Shockwave Flash, Images, 
HTML, or Firmware.

• {Estimated | Planned}— Respectively:

– An estimate of the actual running time from start to finish of the described asset, 
without regard for the amount of time the playlist has reserved to show it.

– The amount of time that is reserved in the playlist to show this asset.

A planned duration of 0 (zero) seconds in the playlist causes a video to play from 
beginning to end. To skip a video instead of playing it, you must remove it from the 
playlist. Nonvideo assets must have a duration of 1 second or more for each that you 
include in a playlist.

• Size — The file size.

• Delete —  

To select additional assets from your media library that this playlist should include, click 
Add Assets. To change the sequence of playback for assets in this playlist, select an asset 
that should move and then click either Move Playlist Item Up or Move Playlist Item 
Down.

Randomize Enables or disables a randomized sequence of playback for assets in this playlist. To turn 
randomization on, check the check box. To turn randomization off, uncheck the check box.

Resolution Choose the resolution of your DMP display from the Select list or enter its width and 
height, in pixels.

Description A description of this playlist. The description is optional.

Playlist Owner Your name or the name of the person who manages this playlist.
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Using Advanced Tasks
Many advanced tasks and options are available to you in DMM-DSM. Your expectations and goals for 
your digital signage network determine which tasks and options are relevant to you at any particular time 
or for any particular purpose. 

Step 1 Select Digital Media Players > Advanced Tasks, and then click an application name in the Application 
Types list, as follows:

Step 2 (Optional) If you previously defined or configured options for the relevant application and you saved 
your selections, click any row in the Applications table to select one of the operations that you defined; 
the row that you click should be one that you want to edit, deploy to DMPs, or delete.

Step 3 Do one of the following:

• To define or configure options for a new operation, click Add New Application.

• To edit the options that you previously defined or configured for the operation that you selected in 
Step 2, click Edit Application.

• To delete the operation that you selected in Step 2, click Delete Application.

Step 4 If you clicked Add New Application or Edit Application, the page is refreshed and you can 
select options or enter values that define or redefine the behavior for this operation.

Application Type Purpose

(Go to) URL Load media from a web server into TVzilla, the embedded browser on a DMP. See the “Go to 
URL” section on page 3-57.

DMP Audio/Video Settings Adjust the audio and video signals that DMPs send to their attached DMP displays. See the 
“DMP Audio/Video Settings” section on page 3-57.

DMP Discovery Autoregister the DMPs in a network range that you specify and add those DMPs to 
DMM-DSM for centralized management. See the “DMP Discovery” section on page 3-58.

DMP Display Controls Bind together a group of RS232 instructions that you can use to remotely configure display 
settings on some DMTECH and NEC display models when displays of these types are 
attached to your DMPs. See the “DMP Display Controls” section on page 3-59.

DMP Failover Retry Set the DMP Recovery URL value and the Recovery Timeout value. See the “DMP Failover 
Retry” section on page 3-59.

DMP Firmware Upgrade Select firmware upgrades and patches to send to one or more DMPs. See the “DMP Firmware 
Upgrade” section on page 3-60.

DMP Startup URL Configure DMPs to load a particular HTTP URL when you start or restart them. See the “DMP 
Startup URL” section on page 3-61.

File Transfer to DMP 
or Server

Use HTTP pulling or use FTP to transfer to your DMPs, or use FTP to transfer to your FTP 
servers (external deployment servers), the:

• Assets from presentations that you prepared in Digital Media Designer.

• Commands and settings from advanced tasks that you selected or configured under the 
Digital Media Players tab. 

See the “File Transfer to DMP or Server” section on page 3-62.

System Tasks Select an administrative command to send to one or more DMPs. See the “System Tasks” 
section on page 3-63. 
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Step 5 To save your selections, click Submit. Otherwise, click Cancel to discard your selections.

Step 6 To deploy to your DMPs the commands that you saved in Step 5, see Scheduling Time Slots for Media 
and Events on DMPs, page 3-73.

Table 3-19 Understanding and Using Advanced Tasks

Application Name Description, Icons, and Options

Go to URL Load media from a web server into TVzilla, the embedded DMP browser. 

— Name— A unique and human-readable name for the website that you will select to show in this 
task. You must enter a name. The name is unique in the sense that you have not used it previously 
as the name for anything that can be scheduled.

— Description — A brief description. The description is optional.

— URL — The full and correct HTTP URL that points to a page or file on a webserver. The URL 
that you enter should point to a page that is dynamic and does not require any human interaction 
(such as clicking or scrolling) to be useful or interesting. You must enter a URL.

DMP Audio/Video 
Settings

Adjust the audio and video signals that DMPs send to their attached DMP displays. 

— Name— A unique and human-readable name for the settings that you configure in this task. For 
example, you might adjust the brightness setting to accommodate a locale where the lighting is 
dim, then enter a name that identifies that kind of locale. You must enter a name. The name is 
unique in the sense that you have not used it previously as the name for anything that can be 
scheduled.

— Description — A brief description. The description is optional.

— Brightness — The setting that compensates for any deficiencies in the on-screen brightness of 
your DMP displays. Brightness compensation values can range from –128 to 127. 

— Contrast— The setting that compensates for any deficiencies in the on-screen contrast of your 
DMP displays. Contrast compensation values can range from 0 to 255. The default is 128.

— Saturation— The setting that compensates for any deficiencies in the on-screen color saturation 
of your DMP displays. Saturation compensation values can range from 0 to 255. The default 
is 128.

— Left Audio Channel Volume — The setting to control how loudly or softly your DMP display 
speakers play sound in the left audio channel. Volume can range from 0 to 100, where 0 is silent. 
The default is 50.

— Right Audio Channel Volume — The setting to control how loudly or softly your DMP display 
speakers play sound in the left audio channel. Volume can range from 0 to 100, where 0 is silent. 
The default is 50.
3-57
User Guide for Cisco Digital Media Manager 5.0

OL-15762-01



  

Chapter 3      Managing Digital Signage and Enterprise TV
  Using Advanced Tasks
DMP Discovery Autoregister the DMPs in a network range that you specify and add those DMPs to DMM-DSM for 
centralized management. For autoregistration and centralized management to succeed:

• Your firewall must allow DMM-DSM and your DMPs to communicate over TCP port 7777 and 
must also allow ICMP (ping) traffic on this port. 

• In DMPDM, you must enable the Enable Cisco TAC Troubleshooting Access option.

To learn about other autoregistration options for the DMPs in your digital signage network, see the 
“{Add New | Edit} DMP” row in Table 3-2 on page 3-7.

Note DMP autoregistration operations occur in sequence and cannot overlap. You should not 
schedule multiple DMP autoregistration operations that overlap or run simultaneously. If you 
do, only the first such operation will run and DMM-DSM will not show any error message 
to explain why the other autoregistration operations failed to find any DMPs. If you must run 
autoregistration tasks that search different subnets, schedule a 35-minute interval between 
the start time for one autoregistration and the start time for the next autoregistration.

— Name— A unique and human-readable name for this autoregistration IP address range task. You 
must enter a name. The name is unique in the sense that you have not used it previously as the 
name for anything that can be scheduled.

— Description — A brief description. The description is optional.

— Discovery IP Range— The NMAP syntax to describe one or multiple ranges of IP addresses.

Table 3-19 Understanding and Using Advanced Tasks (continued)

Application Name Description, Icons, and Options
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DMP Display Controls Note Before you can use this feature, you must enable RS-232 support for your displays. Select 
Digital Media Players > Advanced Tasks > System Tasks, then name, save, and deploy 
one of these as the correct option for your display type:

• Turn On DMTech RS-232 Control.
• Turn On NEC RS-232 Control. 

Bind together a group of RS-232 instructions that you can use to remotely configure display settings.

Tip To learn about the RS-232 commands that manage Cisco LCD displays, see Using RS-232 
Commands to Manage Cisco LCD Professional Series Displays, page 3-64.

— TV Type— Select the manufacturer and the model type:

• {DMTECH | NEC_3210 | NEC_4010 | NEC_4610 | NEC_5710}

— Contrast — Select or enter a contrast value from 0 to 100.

— Brightness — Select or enter a brightness value from 0 to 100.

— Sharpness — Select or enter a sharpness value from 0 to 100.

— Color — Select or enter a color value from 0 to 100.

— Tint — Select or enter a tint value from 0 to 100.

— TV Channel — Select or enter the analog television signal frequency for a channel from 0 to 99.

— Audio Volume — Select or enter a volume level from 0 to 100.

— Mute — Select whether to mute the display.

• {on | off}

— Input — Select the input type. Options differ, according to your selection from the TV Type list. 

• {TV | RGB | RGB1 (DVI-D) | RGB2 (D-SUB) | RGB3 (BNC) | DVD/HD | 
Video (Composite) | Video 1 | Video 2 | Video 3 | S-Video | None (DVD) | 
Component | PC | HDMI | None (DVBT)}

— Power — Select whether the television should be turned on.

• {on | off}

DMP Failover Retry Configure the recovery URL to use in case of failover and the interval between attempts to reload 
that URL if the connection to it is disrupted.

— Name— A unique and human-readable name for the DMP failover retry task that you are 
configuring. You must enter a name. The name is unique in the sense that you have not used it 
previously as the name for anything that can be scheduled.

— Description — A brief description. The description is optional.

— Recovery URL — The URL to show immediately on a DMP display after its attached DMP 
restarts for any reason, unless other content is scheduled to be shown. If this value is blank, your 
DMP will reuse the most recent URL that failed to load.

— Recovery Timeout (in seconds)— The maximum number of seconds that your DMP will wait 
for a response from the server that you identify in the Recovery URL field before it tries again 
to reach that server. There is no maximum number of retry attempts.

Table 3-19 Understanding and Using Advanced Tasks (continued)

Application Name Description, Icons, and Options
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DMP Firmware 
Upgrade

Caution Before you install an upgrade, you must run the “Stop All Applications” system task on 
all the affected DMPs. To do so, click the Schedules tab, select the DMP group that you 
will upgrade, select Stop All Applications from the Actions list, then click Go.

Note Before you transfer a firmware upgrade file to the SD memory card in a DMP, you must 
configure, save, and deploy a system task that causes your DMP to accept the transfer. Select 
Digital Media Players > Advanced Tasks, click System Tasks in the list of defined tasks, 
then click Add New Application. Enter a name and description, then select Set from the 
Request Type list and use this syntax in the Request field: 
init.startService_shell=yes&mib.save=1&mng.exit=1. 
To restore DMP security after the file transfer is finished, repeat the procedure but use this 
syntax instead: init.startService_shell=no&mib.save=1&mng.exit=1. 

Send a DMP firmware image from your media library to a DMP and send commands to install the 
new firmware image. 

— Name— A unique and human-readable name for the upgrade task that you are configuring. You 
must enter a name. The name is unique in the sense that you have not used it previously as the 
name for anything that can be scheduled.

— Description — A brief description. The description is optional.

— Media Categories— An object selector that lists all the categories in your media library. From 
the object selector, click the one category that the Available Content table should describe. To 
learn more about categories, see Working with Assets and Categories in Your Media Library, 
page 3-27. 

• Opened Media Library — Shows all the categories in your media library until you click 
to hide them.

• Closed Media Library — Hides the list of categories until you click to show them.

• Content Category — A media library category that you created.

— Available Content — Click a row to select an asset in the category. Its attributes are:

• Name— A unique and human-readable name that you entered.

• Source — Says whether the asset is a file (F) or an HTTP URL (U).

• Data Type— Identifies the type of asset.

• Size — The file size in bytes.

• Path— The full pathname that points to the file on the DMP.

• Description — A brief description. The description is optional.

• Upload Started — Time stamp (in the format YYYY-MM-DD hh:mm:ss:ms) that says when 
you started to upload the file. 

• Upload Finished — Time stamp (in the format YYYY-MM-DD hh:mm:ss:ms) that says when 
the file was completely uploaded.

• Status — Says whether a DMP is reachable. A green icon ( ) tells you that the DMP is 
connected to a power source, uses a known IP address, and is reachable. A red icon ( ) tells 
you that the DMP is unreachable. 

Table 3-19 Understanding and Using Advanced Tasks (continued)

Application Name Description, Icons, and Options
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DMP Startup URL Causes DMPs to load and show media that you specify, immediately after every restart. 

Tip We recommend that you enter a value for either the Video URL or the Browser URL. If both 
values are blank, you might find that your DMP sometimes loses its ability to play even the 
Shockwave Flash files that it has played successfully in the past. 

— Name— A unique and human-readable name for the startup URL task that you are configuring. 
You must enter a name. The name is unique in the sense that you have not used it previously as 
the name for anything that can be scheduled.

— Description — A brief description. The description is optional.

— Video URL — The HTTP URL (or local path on the DMP) that points to an encoded digital 
video file that a DMP should load automatically and show immediately after every restart. We 
do not support any use of spaces in filenames or URLs. The supported transport protocols and 
URL types are:

• http://<ip_address>/<path_and_filename>

• udp://<ip_address_of_multicast_server>/<port_number>

— Browser URL — The HTTP URL of any document that TVzilla, the embedded browser on a 
DMP, should load automatically and show immediately after each restart. We do not support any 
use of spaces in URLs. We recommend that you do not point to any document or site that 
requires human interaction to be useful, interesting, or entertaining, because there is no 
keyboard or mouse that you can use to interact with what you show on a DMP display.

— Reboot Necessary? — Check the check box if a DMP should restart immediately when it 
receives this instruction. Uncheck the check box if no immediate restart is required.

Table 3-19 Understanding and Using Advanced Tasks (continued)

Application Name Description, Icons, and Options
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File Transfer to DMP 
or Server

Caution Before you use a file transfer application to deploy the assets from a new or updated 
presentation to any of your DMPs, you must first run the “Stop All Applications” system 
task on each affected DMP. To do so, click the Schedules tab, select the DMP group that 
will use the presentation, select Stop All Applications from the Actions list, then 
click Go. 

Use HTTP pulling or FTP to transfer to particular DMPs or to external (FTP) deployment servers the 
assets from presentations that you prepared in DMD, the media and electronic program guides for 
Enterprise TV, or the commands and settings from advanced tasks. (Although it is technically 
possible, it is not useful to transfer a system task, a go to URL task, or a startup URL task.) See 
Scheduling Time Slots for Media and Events on DMPs, page 3-73. 

— Name— A unique and human-readable name for the file transfer task that you are configuring. 
You must enter a name. The name is unique in the sense that you have not used it previously as 
the name for anything that can be scheduled.

— Description — A brief description. The description is optional.

—

Caution HTTP pulling is highly scalable but can result in a distributed denial-of-service (DDoS) 
attack against any server, such as your DMM appliance, that is not built and configured 
to withstand the resulting load. If you choose HTTP as the protocol, be sure that your 
DMPs will pull all files from ACNS or another system that can tolerate the load. 

DMP Publishing Protocol — Choose HTTP or FTP as the protocol for the file transfer task. 

— Emergency/Alarm—Check (tick) this box if the transferred files will be used during emergencies. 
Otherwise, do not check this box. Assets for emergencies are saved to a special partition

— Application Types — The list of categories for advanced tasks. Click a category to see its tasks.

— Available Applications— Advanced tasks in the category that you clicked. Click anywhere in a 
row to select the corresponding task.

• Select Applications — Moves from the Available Applications table to the Selected 
Applications table the tasks that you selected.

• Name— The unique and human-readable name that identifies a particular task.

• Description — A brief description. The description is optional.

— Selected Applications — Advanced tasks that you selected from the Available Applications 
table, so that you could include them in the file transfer operation that you are configuring. Click 
a file transfer task to select its assets for deployment.

• / Move Selected Item Up/Down — Reorders the list so that the highlighted item 
moves up (or down) one row, exchanging places with the item that was above it (or below it).

• Delete Selected Item — Moves from the Selected Applications table to the Available 
Applications table the applications that you selected.

• / Zoom In/Out— Shows only the Selected Applications table, hiding the Available 
Applications table. Alternatively, shows the Selected Applications table and the Available 
Applications table simultaneously.

Table 3-19 Understanding and Using Advanced Tasks (continued)

Application Name Description, Icons, and Options
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System Tasks

Caution If you restore factory-default settings on a DMP, you must set it up again, exactly as you 
would set up a brand-new DMP. (To learn how to set up a DMP, see the quick start guide 
on Cisco.com for your DMP model.) If you restart a DMP, you will disrupt whatever it is 
doing at that time. If you save any configuration settings mistakenly, you must reenter the 
correct settings manually. 

Predefined system commands that you can send to a DMP. If you will use this feature to pass RS-232 
commands through your DMPs and to your DMP displays, first confirm that an RS-232 cable 
connects each DMP to its associated DMP display; otherwise, your displays will not receive the 
commands that you define for them.

When you create or edit a system task, these are the elements:

• Name— A unique and human-readable name for the system task that you are configuring. You 
must enter a name. The name is unique in the sense that you have not used it previously as the 
name for anything that can be scheduled.

• Description — A brief description. The description is optional.

• Request Type— A list in which the options are Get and Set, in the sense that you can set new 
values on a DMP or instruct DMM-DSM to get information from a DMP and show that 
information in a popup window. 

• Request — The command string. 

— Default— Restore factory default settings.

— FTP {Off | On} — Enable or disable the FTP service.

— HDMI Autodetection {Off | On}— Enable or disable DMP display type autodetection.

— Reboot— Restart.

— Save Settings— Save the active settings.

— Save Settings and Reboot — Save the active settings, then restart.

— Screen Resolution Autodetection {Off | On} — Enable or disable autodetection of the 
resolutions that your DMP displays support.

— Show {Browser | Video}— Show one content plane but hide the other.

— Status — See the DMP status message in real time.

— Stop All Applications— Stop every application that DMPs are running.

— Transparency 50%— Set the browser plane (TVzilla) to be partially transparent and show the 
video plane through it.

— Turn On DMTech RS-232 LCD Control — Cause DMPs to send RS-232 management 
instructions to an LCD display manufactured by DMTech.

— Turn On NEC RS-232 LCD Control — Cause DMPs to send RS-232 management instructions 
to an LCD display manufactured by NEC.

— Upgrade Status— See the DMP upgrade status message in real time.

— Version— See the installed firmware version number.

Table 3-19 Understanding and Using Advanced Tasks (continued)

Application Name Description, Icons, and Options
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Using RS-232 Commands to Manage Cisco LCD Professional Series Displays
When you use an HDMI cable or a DVI cable to connect your DMP to an LCD display model from the 
Cisco LCD Professional Series, you can use DMM-DSM to centrally manage the LCD display. 

When HDMI is the connection type from a DMP to a Professional Series display, centralized 
management from DMM works immediately, without any prerequisites. However, when DVI is the 
connection type, you must prepare your LCD display before you can start to centrally manage it.

• Preparing a Cisco LCD Display for Centralized Management Through DVI, page 3-64

• RS-232 Command Reference for Cisco LCD Displays, page 3-64

Preparing a Cisco LCD Display for Centralized Management Through DVI

When HDMI is the connection type from a DMP to a Professional Series display, centralized 
management from DMM works immediately, without any prerequisites. However, when DVI is the 
connection type, you must complete a simple task at the physical installation site for your LCD display 
before you can start to centrally manage it.

Procedure

Step 1 Do either of the following:

• On the remote control for your LCD display, press Menu.

• On the front panel of your LCD display, press Menu.

Step 2 Choose Input > Source List > DVI, and then press Enter.

Step 3 Choose Input > Edit Name > DVI > HD STB, and then press Enter.

RS-232 Command Reference for Cisco LCD Displays

Tables in this section describe RS-232 command strings that you can use for centralized management of 
LCD display models from the Cisco LCD Professional Series:

• LCD 100-Pro-40N (40" model)

• LCD-110-Pro-52S (52" model)

The RS-232 command strings are described in these tables:

• Turning the Display On and Off, page 3-65

• Muting and Unmuting the Display, page 3-65

• Adjusting Brightness, page 3-65

• Adjusting Colorfulness, page 3-65

• Adjusting Contrast, page 3-65

• Turning the Remote Control On and Off, page 3-65

• Locking and Unlocking the Display and Its Remote Control, page 3-66
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Turning the Display On and Off

Muting and Unmuting the Display

Adjusting Brightness

Adjusting Colorfulness

Adjusting Contrast

Turning the Remote Control On and Off

Task RS-232 Syntax

Turn on the display rs232.tx_hex=aa11fe010111

Turn off the display rs232.tx_hex=aa11fe010010

Task RS-232 Syntax

Mute the display rs232.tx_hex=aa13ff010114

Unmute the display rs232.tx_hex=aa13ff010013

Task RS-232 Syntax

Set brightness to 50 percent rs232.tx_hex=aa25ff013257

Set brightness to 75 percent rs232.tx_hex=aa25ff014b70

Set brightness to 100 percent rs232.tx_hex=aa25ff016489

Task RS-232 Syntax

Set colorfulness1 to 50 percent

1. An image with a colofulness value of zero percent is grayscale, while the same image with a colorfulness value of 100 percent has vivid colors.

rs232.tx_hex=aa27ff013259

Set colorfulness to 75 percent rs232.tx_hex=aa27ff014b72

Set colorfulness to 100 percent rs232.tx_hex=aa27ff01648b

Task RS-232 Syntax

Set contrast to 50 percent rs232.tx_hex=aa24ff013256

Set contrast to 75 percent rs232.tx_hex=aa24ff014b6f

Set contrast to 100 percent rs232.tx_hex=aa24ff016488

Task RS-232 Syntax

Turn on the remote control rs232.tx_hex=aa36ff010137

Turn off the remote control rs232.tx_hex=aa36FF010036
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Locking and Unlocking the Display and Its Remote Control

Planning for and Responding to Emergencies
When emergencies of any kind affect sites where you deploy digital signage, you can use DMP displays 
to alert your viewers, warn them about dangers that might affect them, and direct them to safety. Or you 
can provide other kinds of information to them as you see fit. Until you stop playing emergency 
messages, they override all events that were scheduled to run automatically. 

It is important to remember that emergency message insertions in your schedule will override only the 
events that are scheduled to run automatically. Furthermore, such insertions will override these events 
on only the DMPs that the emergency message insertion affected. All other DMPs in your network will 
abide by their schedule, without disruption. To understand the schedule and learn about the manual and 
automatic methods for scheduling, see Scheduling Time Slots for Media and Events on DMPs, 
page 3-73.

Emergency conditions might prevent messages from playing on your DMP displays.

Note Consider very carefully which DMM-DSM users should have permission to work with your schedule 
and manage your DMP groups. Although all of the “Play in Future” features are suspended (for affected 
DMPs only) while an emergency is in progress, none of the “Play Now” features or “DMP Manager” 
features are suspended. Therefore, it is possible for a user with sufficient permissions to start another 
event manually on the DMPs where an emergency message should be playing. 

If policies in your organization require of you that one or more screen zones must show assets that are 
editable, you can stage the editable assets remotely on one of your external deployment servers instead 
of staging them locally on your DMPs. Then, the people in your organization who are entrusted to edit 
these assets can change them — to update the emergency message, for example— in real time.

After an emergency has stopped and normal scheduling has resumed on a DMP group and its children, 
any playlist or presentation that was scheduled for playback at that time will start from the beginning.

The emergency messaging features in DMM-DSM are designed with these scenarios in mind:

• Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately, page 3-67

• Emergency Scenario 2: Schedule the Staging of Assets to DMP Local Storage, page 3-68

• Emergency Scenario 3: Schedule the Staging of Assets to a Remote Server, page 3-69

• Emergency Scenario 4: Start Playback of an Emergency Message, page 3-71

• Emergency Scenario 5: Stop Playback of an Emergency Message, page 3-72

Task RS-232 Syntax

Lock all features rs232.tx_hex=aa5dff01015e

Unlock all features rs232.tx_hex=aa5dff01005d
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Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately
In this scenario, you start immediately to transfer assets for emergency messaging that will be staged 
locally on your DMPs. This scenario decribes one of three possible staging methods that you can use to 
deploy assets for use during an emergency. To learn about the two other staging methods, see Emergency 
Scenario 2: Schedule the Staging of Assets to DMP Local Storage, page 3-68, and Emergency Scenario 
3: Schedule the Staging of Assets to a Remote Server, page 3-69.

Before You Begin

• This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can 
use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and 
obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and 
then go to http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656.

• This scenario assumes that you already created the playlist or presentation whose assets you will 
transfer to your DMPs. See Working with Presentations, Templates, and Presentation Playlists for 
Digital Signage, page 3-33.

Step 1 Choose Digital Media Players > Advanced Tasks, and then click File Transfer to DMP or Server.

Step 2 To create a new file transfer task, click Add New Application.

Step 3 After the page is refreshed, do the following to define behaviors for, and save, the file transfer task:

a. Enter a specific name, such as “Fire” or “Flash Flood,” for the type of emergency. You might want 
to use a less specific name, such as “Emergencies,” if this task will transfer the assets for multiple 
presentations or playlists, or if your organization uses one playlist or presentation for emergencies 
of all kinds.

b. From the DMP Publishing Protocol list, choose FTP or HTTP, and then check the 
Emergency/Alarm check box.

c. If the assets are part of a saved presentation, click Presentations in the Applications list. 
Alternatively, if the assets are part of a saved playlist, click Playlists.

d. After the page is refreshed, click in the Available Applications list the name of the presentation or 
playlist whose assets should be transferred, and then click Select Applications. 

e. (Optional) To transfer the assets for multiple playlists and presentations, repeat the preceding step.

f. To save this task, so that it becomes available for your use, click Submit. 

Note Even though you created and saved a file transfer task, you have not used it yet. Your DMPs 
will not have local copies of the emergency assets until after you run this task successfully.

Step 4 To transfer the emergency assets to your DMPs immediately, use one of the following methods.

DMP Manager Method

a. Click the DMP Manager tab and then, in the DMP Groups tree, click the name of the group whose 
member DMPs should have local copies of the emergency assets.

b. In the Actions list, scroll down to the File Transfer to DMP or Server section and choose the name 
of the task you created in Step 3.

c. To issue the command immediately that transfers copies of the assets to your DMPs, and to create 
as many Go-to URL entries (all using the prefix “Alarm”) as the number of presentations and 
playlists you selected in Step 3, click Go.
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Play Now Method

a. Choose Schedules > Play Now.

b. From the Select an Event Type list, choose System Tasks and then click Select System Tasks.

c. After the Select Event dialog box opens, click File Transfer to DMP or Server (in the Type 
column) and then click the name of the task you created in Step 3 (in the Application Name column).

d. To confirm your selection and close the Select Event dialog box, click OK.

e. In the DMP Groups tree, click the name of the group whose member DMPs should have local copies 
of the emergency assets.

f. To issue the command immediately that transfers copies of the assets to your DMPs, and to create 
as many Go-to URL entries (all using the prefix “Alarm”) as the number of presentations and 
playlists you selected in Step 3, click Submit.

Emergency Scenario 2: Schedule the Staging of Assets to DMP Local Storage
In this scenario, you schedule a time in the future to transfer assets for emergency messaging that will 
be staged locally on your DMPs. This scenario decribes one of three possible staging methods that you 
can use to deploy assets for use during an emergency. To learn about the two other staging methods, see 
Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately, page 3-67, and Emergency 
Scenario 3: Schedule the Staging of Assets to a Remote Server, page 3-69.

Before You Begin

• This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can 
use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and 
obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and 
then go to http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656.

• This scenario assumes that you already created the playlist or presentation whose assets you will 
transfer to your DMPs. See Working with Presentations, Templates, and Presentation Playlists for 
Digital Signage, page 3-33.

Step 1 Choose Digital Media Players > Advanced Tasks, and then click File Transfer to DMP or Server.

Step 2 To create a new file transfer task, click Add New Application.

Step 3 After the page is refreshed, do the following to define behaviors for, and save, the file transfer task:

a. Enter a specific name, such as “Fire” or “Flash Flood,” for the type of emergency. If you will transfer 
the assets for multiple presentations or playlists, you might want to use a less specific name, such 
as “Emergencies.”

b. From the DMP Publishing Protocol list, choose FTP or HTTP, and then check the 
Emergency/Alarm check box.

c. If the assets are part of a saved presentation, click Presentations in the Applications list. 
Alternatively, if the assets are part of a saved playlist, click Playlists.

d. After the page is refreshed, click in the Available Applications list the name of the presentation or 
playlist whose assets should be transferred, and then click Select Applications. 

e. (Optional) To transfer the assets for multiple playlists and presentations, repeat the preceding step.

f. To save this task, so it becomes available for your use, click Submit. 
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Note Even though you created and saved a file transfer task, you have not used it yet. Your DMPs 
will not have local copies of the emergency assets until after you run this task successfully.

Step 4 To schedule the future transfer of the emergency assets to your DMPs, choose Schedules > Play in 
Future, and then do the following:

a. From the calendar, choose the year, month, and day when the assets should be transferred. The 
timeline is updated automatically, so that it shows the schedule for that day.

b. From the Event Type list, which is located under the timeline, choose System Tasks.

c. After the Schedule Task dialog box opens, use it to choose the DMPs:

1. Click Select Group, and then click the name of the group whose member DMPs should have 
local copies of the emergency assets. 

2. To confirm your selection and close the Select DMP Group dialog box, click OK.

d. Choose the task:

1. Click Select System Tasks. 

2. After the Select System Tasks dialog box opens, click File Transfer to DMP or Server (in the 
Types list), and then click the name of the task you created in Step 3 (in the untitled table).

3. To confirm your selection and close the Select System Tasks dialog box, click OK.

You can use the provided controls to adjust the start and stop time for this task. Remember to allow 
sufficient time for the transfer to complete. The amount of time required can vary according to the 
cumulative file size of the selected assets, the capacity of your network, any congestion in your 
network, and possibly other factors. Emergency conditions might prevent messages from playing on 
your DMP displays.

Do not use any of the provided controls for repeating a task.

e. To confirm your selections and close the Schedule Task dialog box, click Save.

f. To save your selections, click Save All.

g. To transmit the deployment according to the schedule that you defined, click Publish All.

Emergency Scenario 3: Schedule the Staging of Assets to a Remote Server
In this scenario, you schedule a time in the future to transfer assets for emergency messaging that will 
be staged on an FTP server or a webserver. This scenario decribes one of three possible staging methods 
that you can use to deploy assets for use during an emergency. To learn about the two other staging 
methods, see Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately, page 3-67, and 
Emergency Scenario 2: Schedule the Staging of Assets to DMP Local Storage, page 3-68.
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Before You Begin

• This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can 
use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and 
obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and 
then go to http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656.

• This scenario assumes that you already:

– Entered and saved login credentials for an external server, such as an FTP server or a webserver. 
See Configuring DMM-DSM to Deploy to External Servers, page 3-88.

– created the playlist or presentation whose assets you will transfer to your DMPs. See Working 
with Presentations, Templates, and Presentation Playlists for Digital Signage, page 3-33.

Step 1 Choose Digital Media Players > Advanced Tasks, and then click File Transfer to DMP or Server.

Step 2 To create a new file transfer task, click Add New Application.

Step 3 After the page is refreshed, do the following to define behaviors for, and save, the file transfer task:

a. Enter a specific name, such as “Fire” or “Flash Flood,” for the type of emergency. If you will transfer 
the assets for multiple presentations or playlists, you might want to use a less specific name, such 
as “Emergencies.”

b. From the DMP Publishing Protocol list, choose FTP or HTTP, and then check the 
Emergency/Alarm check box.

c. If the assets are part of a saved presentation, click Presentations in the Applications list. 
Alternatively, if the assets are part of a saved playlist, click Playlists.

d. After the page is refreshed, click in the Available Applications list the name of the presentation or 
playlist whose assets should be transferred, and then click Select Applications. 

e. (Optional) To transfer the assets for multiple playlists and presentations, repeat the preceding step.

f. To save this task, so it becomes available for your use, click Submit. 

Note Even though you created and saved a file transfer task, you have not used it yet. Your extenal 
servers will not have copies of the emergency assets until after you run this task successfully.

Step 4 To schedule the future transfer of the emergency assets to your external servers, choose Schedules > 
Play in Future, and then do the following:

a. From the calendar, choose the year, month, and day when the assets should be transferred. The 
timeline is updated automatically, so that it shows the schedule for that day.

b. From the Event Type list, which is located under the timeline, choose System Tasks.

c. After the Schedule Task dialog box opens, use it to choose the DMPs:

1. Click Select Group, and then click the name of the group whose member DMPs should have 
local copies of the emergency assets. 

2. To confirm your selection and close the Select DMP Group dialog box, click OK.

d. Choose the task:

1. Click Select System Tasks. 

2. After the Select System Tasks dialog box opens, click File Transfer to DMP or Server (in the 
Types list), and then click the name of the task you created in Step 3 (in the untitled table).

3. To confirm your selection and close the Select System Tasks dialog box, click OK.
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You can use the provided controls to adjust the start and stop time for this task. Remember to allow 
sufficient time for the transfer to complete. The amount of time required can vary according to the 
cumulative file size of the selected assets, the capacity of your network, any congestion in your 
network, and possibly other factors. Emergency conditions might prevent messages from playing on 
your DMP displays.

Do not use any of the provided controls for repeating a task.

e. To confirm your selections and close the Schedule Task dialog box, click Save.

f. To save your selections, click Save All.

g. To transmit the deployment according to the schedule that you defined, click Publish All.

Emergency Scenario 4: Start Playback of an Emergency Message

Before You Begin

• This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can 
use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and 
obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and 
then go to http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656.

• This scenario assumes that you already completed Scenario 1 or Scenario 2 and transferred to your 
DMPs the supporting assets for a playlist or presentation that your DMPs should show during an 
emergency. To learn about these scenarios, see:

– Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately, page 3-67

– Emergency Scenario 2: Schedule the Staging of Assets to DMP Local Storage, page 3-68.

Step 1 Do one of the following:

• Choose Digital Media Players > Emergencies. 

• Choose Schedules > Emergencies.

Step 2 Click Start Emergency.

Step 3 From the Select Emergency list, choose the playlist or presentation that your DMPs should play during 
the type of emergency that is now in progress.

Entries that you see in the Select Emergency list are derived from file transfer tasks that you saved after 
checking the Emergency/Alarm check box. You cannot add the “ALARM” prefix manually to the name 
of a Go-to URL task to make the task appear in the Select Emergency list. Nor can you delete the 
“ALARM” prefix manually from the name of a Go-to URL task to exclude the task from the Select 
Emergency list.

Step 4 Expand the Select DMP Group tree, click the entry for the DMP group whose member DMPs should all 
announce the emergency, and then click Start.

If you choose a DMP group that has child groups, the child groups and their member DMPs are also 
selected automatically.

While this emergency is in-progress, the event-scheduling features at Schedule > Play in Future will be 
suspended temporarily for whichever group and children you chose. However, your other DMP groups 
will not be affected. You still can schedule events for those other groups. Later, after you stop this 
emergency, the event-scheduling features at Schedule > Play in Future will be restored for the group and 
children that you chose. 
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Step 5 To confirm your selections and start playback immediately of your emergency presentation or emergency 
playlist, click OK. (Emergency conditions might prevent messages from playing on your 
DMP displays.) Alternatively, to discard your selections without playing any assets for any emergency, 
click Cancel.

A message tells you whether you submitted the emergency successfully. After you dismiss the message, 
the page is refreshed. If you submitted the emergency, the DMP group that you chose in Step 4 is colored 
red in the Select DMP Group tree.

Tip You can submit an emergency to a DMP group while it is showing a playlist or presentation that 
describes some other emergency. There is no need to explicitly stop playback of the current emergency 
message before you start another one. 

Emergency Scenario 5: Stop Playback of an Emergency Message

Before You Begin

• This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can 
use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and 
obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and 
then go to http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656.

• This scenario assumes that you already have started playback of an emergency message. See 
Emergency Scenario 4: Start Playback of an Emergency Message, page 3-71.

Step 1 Do one of the following:

• Choose Digital Media Players > Emergencies. 

• Choose Schedules > Emergencies.

Step 2 Click Stop Emergency.

Step 3 Expand the Select DMP Group tree, click the DMP group that is colored red, and then click Stop.

If you choose a DMP group that has child groups, the child groups and their member DMPs are also 
selected automatically.

Step 4 To confirm your selections, which will stop playback of your emergency message and restore normal 
scheduling for the DMP group (and children) that you chose, click OK. Alternatively, to discard your 
selections without stopping the emergency, click Cancel.

A message tells you whether you stopped the emergency successfully. After you dismiss the message, 
the page is refreshed. If you stopped the emergency, the DMP group that you chose in Step 3 is no longer 
colored red in the Select DMP Group tree. 

If you selected a DMP group whose member DMPs were not showing emergency messages, these DMPs 
will stop and then restart their playback of whatever asset they are scheduled to show. 

If separate emergencies were in effect simultaneously across multiple DMP groups and you stopped the 
emergency for only one group, remember that the event-scheduling features at Schedule > Play in Future 
still are suspended for all groups where emergencies remain in effect.
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Scheduling Time Slots for Media and Events on DMPs

Tip Network congestion or other performance problems at a DMP deployment site might cause the assets 
that you deploy to pause, stop, or play at unacceptably low speeds. To work around this problem, 
troubleshoot network performance at the deployment site and consider upgrading its network or applying 
policies to shape and prioritize its traffic.

In DMM-DSM, you can schedule events to start manually (“Play Now”) or run automatically (“Play in 
Future”). Topics in this section tell you how to deliver to your DMPs and servers the assets and 
commands that you saved in DMM-DSM, as well as the TV channels and VoDs that you saved in 
DMM-ETV.

• Deploying Elements Immediately, page 3-73

• Working with Future Deployments, page 3-74

• Preempting a Recurring Event for a One-time Event, page 3-81

• Using Deployment Reports, page 3-81

Note To learn how to configure DMM-DSM support for ACNS, see Configuring DMM-DSM to Use ACNS, 
page 3-87.

Deploying Elements Immediately
An element in DMM is any command, event, presentation, playlist, TV channel, electronic program 
guide, VoD, or anything else that you can schedule for deployment to DMPs. You can deploy elements 
immediately to one DMP or to multiple DMPs that all use the same one DMP group as their parent.

Note • In this release, we do not support immediate deployments to external (FTP) servers.

• We recommend that you avoid using immediate deployments with ACNS, due to the amount of time 
required to distribute assets throughout your network and to its edge. If you do so despite this 
recommendation, DMM-DSM always uses the default ACNS channel. You cannot select any 
other channel.

Before You Begin

• You must already have created and saved the elements that you will deploy. See Working with Assets 
and Categories in Your Media Library, page 3-27. See also Using Advanced Tasks, page 3-56.

• You must already have created the DMP group whose member DMPs should receive the 
deployment. See Managing and Grouping Your DMPs, page 3-6.

Step 1 Choose Schedules > Play Now.

Step 2 From the Event Type list, choose Digital Signage, Enterprise TV, or System Tasks, depending on 
which of these is the deployment type.

The option that you choose from the Event Type list causes a button to be shown. Its name is derived 
from your choice. 
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Step 3 To choose specifically the element that should be deployed to your DMPs, click this button.

A dialog box opens, from which you can select the specific element to be deployed. The name and 
elements of this dialog box will vary, depending on which option you chose from the Event Type list.

Step 4 Click the name of the specific instruction or media to be deployed, and then do one of the following:

• To confirm your selection and close the dialog box, click OK.

• To discard your selection and close the dialog box, click Cancel.

Step 5 In the DMP Groups object selector, click the name of a DMP group to see a list of its member DMPs.

Step 6 In the list of DMPs, Ctrl-click the name of each DMP that should receive the deployment.

Step 7 Do one of the following:

• To confirm your selections and deploy the element immediately, click Submit.

• To discard your work for this deployment, click Cancel.

Working with Future Deployments
You can schedule future time slots for elements that you will deploy once or repeatedly to:

• One registered DMP, if it belongs to a DMP group which does not contain any other DMPs.

• Multiple registered DMPs that all use the same one DMP group as their parent. 

• All of your registered external (FTP) deployment servers; the schedule treats all of your registered 
external servers identically.

You can schedule a deployment to occur at any time and recur any number of times (within reason), and 
you can schedule any number of deployments. The schedule can manage multiple deployments 
simultaneously and— assuming that a DMP has a fast network connection and you send deployments to 
it that are not mutually exclusive — a DMP can receive multiple deployments simultaneously.

Note Avoid placing entries in your schedule that recur often and persist for an unreasonably long time. 
Otherwise, your manifest files might not be generated quickly enough to meet your expectations. We 
recommend that you apply this rough algorithm:

• An entry that recurs daily should persist in your schedule for no more than 3 days.

• An entry that recurs weekly should persist in your schedule for no more than 3 weeks.

• An entry that recurs monthly should persist in your schedule for no more than 3 months.

• An entry that recurs annually should persist in your schedule for no more than 3 years.

Tip You can view two types of summary for any scheduled deployment. See:

• Understanding Tooltips in the Schedule Timeline, page 3-78

• Viewing Status Messages Inline for Deployed Events in the Schedule Timeline, page 3-79
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This section contains these topics:

• Understanding Future Deployments for Presentations, page 3-75

• Understanding Time Zones in the Schedule, page 3-76

• Scheduling the Time Slot for a Future Event, page 3-76

Understanding Future Deployments for Presentations

You can deploy only one presentation at a time if the assets that it uses should be stored directly on your 
DMPs. To check the free space on the SD memory card in a DMP, log in to its local instance of DMPDM, 
then click Internal Storage. If you want a particular presentation to play during stage-one failover on a 
DMP, the combined file size of all its assets must not be any more than:

• 0.9 GB (900 MB) on a DMP 4300G.

• 1.9 GB on a DMP 4305G.

• 3.8 GB on a DMP 4400G.

Caution Do not delete the scheduled deployment job for a presentation to stop it from playing on your DMPs. If 
you delete the deployment job, your DMPs will continue to use the presentation as if you did nothing. 
This happens because each deployment job includes an instruction to stop, but you delete that instruction 
when you delete the deployment job that contains it. To stop your DMPs from using a presentation in 
this case, create and deploy an advanced task to stop all applications. See the “System Tasks” row in 
Table 3-19 on page 3-57.

Note It is important that you understand all of the possible limitations and effects of deploying to an FTP 
server, as well as the exact circumstances that lead to these effects. Files are sometimes unplayable or 
deleted automatically; subdirectories are sometimes created automatically; and values that you enter in 
DMM-DSM are sometimes changed automatically.

• Video files do not play at all if you deploy a presentation to an FTP server when the presentation 
uses MPEG files that are:

– Served from Microsoft Internet Information Server (IIS). On Windows, we support only Apache.

– Requested through Microsoft Proxy Server.

– Requested through Microsoft Internet Security and Acceleration Server.

• When your media library in DMM-DSM is the source for a file that you deploy as part of a 
presentation, and when you select an FTP server as the target to receive that file, DMM-DSM 
transfers copies of the relevant file to all of the FTP servers that you have registered. After the 
transfer is completed, DMM-DSM deletes the original file from its media library, then changes the 
relevant presentation so that it uses a URL instead of a local path. The URL that DMM-DSM enters 
automatically is specific to whichever FTP server you registered first.

• When an HTTP URL is the source for a deployed file, and when the pathname on the source server 
contains subdirectories that do not exist on the target FTP server, DMM-DSM automatically creates 
the required subdirectories on the FTP server.
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Understanding Time Zones in the Schedule

Future time slots that the schedule describes will always designate hours in boldface numerals according 
to the UTC time zone offset for the locale where your DMM appliance is installed. If you are working 
from any other time zone when you view the schedule, this offset will differ from the offset for your 
locale and the difference might be confusing. Furthermore, the offset might be confusing even if you and 
your DMM appliance are together in one time zone but you want to schedule time slots for a DMP that 
is in some other time zone. 

In either scenario, you can cause the schedule to designate hours from two time zones simultaneously. 
One of these time zones is always the one for your DMM appliance. To choose the second time zone 
(whether it is for your locale or the locale of a DMP), select a named UTC offset option, such as 
“America/Los Angeles,” from the untitled list above the schedule. 

The schedule is updated immediately to show designated hours from the second time zone that you 
selected, in addition to the designated hours that it always shows for your DMM appliance:

• Small, plain numerals designate hours for the UTC-offset locale that you selected. 

• Large, boldface numerals designate hours for the locale where your DMM appliance is installed.

Scheduling the Time Slot for a Future Event 

Tip Displayed times for deployments in the schedule are relative to the time zone where you deployed your 
DMM appliance, not the time zone where you deployed any DMP, and not the time zone for any other 
locale. You set the time zone value for your DMM appliance when you used AAI to configure it and you 
can use AAI to correct the time zone value if it is wrong. 

• To learn how to set or reset the time zone, see the “Administering a DMM Appliance” chapter in 
Appliance Administration Guide for Cisco Digital Media System 5.0 on Cisco.com. 

• To understand how the schedule represents time zones, see Understanding Time Zones in the 
Schedule, page 3-76.

• If the user interface for the schedule does not load correctly in your browser, see Release Notes for 
Cisco Digital Media System 5.0 on Cisco.com. 

Before You Begin

• You must already have created and saved the elements that you will deploy. See Working with Assets 
and Categories in Your Media Library, page 3-27.

• You must already have created the DMP group that should receive a deployment. See Managing and 
Grouping Your DMPs, page 3-6.

Step 1 Choose Schedules > Play in Future.

Step 2 From the calendar, choose the year, month, and day when the deployment should start.

The timeline is updated automatically, so that it shows the schedule for that day.

Step 3 From the Event Type list, under the timeline, choose the deployment type.
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Step 4 When the Schedule Task dialog box opens, complete these steps: 

a. Click Select Group, click the group name for the DMPs or the external (FTP) deployment servers 
that should receive this deployment, and then click OK.

b. Click the Select <event_type> Tasks button, click the name of the specific event to be deployed, and 
then click OK.

c. To designate the start and stop times for this event:

• In the Start Time area— For the deployment date that you chose in Step 2, enter the hour 
(numeric, in the range from 1 to 12) and minute (numeric, in the range from 00 to 59) when 
DMPs should start this event, then enter either AM or PM as the period.

• In the Stop Time area — Use the same method to specify when DMPs should stop this event.

Step 5 From the Repeat list, choose the recurrence interval for this event. The intervals are:

• Never

• Every Day

• Every Week

• Every Month

• Every Year

Step 6 To save your selections, click Save All. 

Note • If you do not click Save All, the schedule discards your selections immediately after you refresh 
your browser or load any other page.

• You must click Save All even if you do not plan to deploy the event right away. Later, when you are 
ready to deploy the event, click Publish All. 

Step 7 (Optional) To make copies of an event in the schedule, so that it recurs as many times as you want and 
at any interval that you specify:

a. Click the event description on the timeline, then choose Add an Event > Duplicate All.

b. Click the first Select button to choose the group whose event will be copied, and then click OK.

c. Click the second Select button to choose the group that should receive the copy, and then click OK.

d. Click Save.

Step 8 To transmit the deployment according to the schedule that you defined — and synchronize it if you use 
ACNS— click Publish All.
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Understanding Tooltips in the Schedule Timeline

Whenever your pointer hovers over a event in the timeline, the schedule shows a tooltip. Information in 
the tooltip describes the current status of the corresponding event and summarizes its most important 
attributes. Information in the tooltip is organized as follows:

Table 3-20

Category Description

Status One of the following:

• New — You made selections to define a new deployment. However, because you have not yet 
clicked Save, the schedule will discard your selections if you refresh your browser or load any 
other page in it.

• Saved— You made selections to define a new deployment and you clicked Save. You created a 
permanent record for the deployment, but have not scheduled it yet to run.

• Published— You made selections to define a deployment, you saved your selections, and the 
deployment is scheduled to run at the times that you specified. 

• Scheduled— The deployment is occurring now.

• Finished — The deployment occurred at the scheduled time and is now stopped.

App The selection that you made from the Applications list.

Group The selection that you made from the DMP Groups list.

From The date and time when the deployment is (or was) scheduled to start.

To The date and time when the deployment is (or was) scheduled to stop.

Repeat The number of times that the deployment is scheduled to recur.

Start Cmd Result 
(Total/OK/Failed)

N/N/N, where:

• The first N is a color-coded (black) numeral that counts the total number of times that DMM-DSM 
tried to deploy the command to start the designated task.

• The second N is a color-coded (green) numeral that counts the number of times that DMM-DSM 
succeeded in deploying the command to start the designated task.

• The third N is a color-coded (red) numeral that counts the number of times that DMM-DSM failed 
to deploy the command to start the designated task.

Stop Cmd Result 
(Total/OK/Failed)

N/N/N, where:

• The first N is a color-coded (black) numeral that counts the total number of times that DMM-DSM 
tried to deploy the command to stop the designated task.

• The second N is a color-coded (green) numeral that counts the number of times that DMM-DSM 
succeeded in deploying the command to stop the designated task.

• The third N is a color-coded (red) numeral that counts the number of times that DMM-DSM failed 
to deploy the command to stop the designated task.
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Viewing Status Messages Inline for Deployed Events in the Schedule Timeline

Whenever you let your pointer hover over a scheduled deployment in the timeline, DMM-DSM describes 
the current status of the corresponding deployment and summarizes its most important attributes. 
Information in the popup is organized as follows:

Table 3-21 Elements to Describe the Current Status of Scheduled Events

Category Description

Application Name The selection that you made from the Applications list.

Application Type Either Digital Media Designer (see Working with Presentations, Templates, and Presentation Playlists 
for Digital Signage, page 3-33) or one of the following (see Using Advanced Tasks, page 3-56):

• (Go to) URL

• DMP Audio/Video Settings

• DMP Discovery (autoregistration)

• DMP Display Controls

• DMP Failover Retry

• DMP Firmware Upgrade

• DMP Startup URL

• File Transfer to DMP or Server

• System Tasks

From The date and time when the deployment is (or was) scheduled to start.

To The date and time when the deployment is (or was) scheduled to stop.

How Often The number of times that the deployment is scheduled to recur.

Status One of the following:

• New — You made selections to define a new deployment. However, because you have not yet 
clicked Save, DMM-DSM will discard your selections if you refresh your browser or load any 
other page in it.

• Saved— You made selections to define a new deployment and you clicked Save. DMM-DSM 
created a permanent record for the deployment, but has not scheduled it yet to run.

• Published— You made selections to define a deployment, you saved your selections, and 
DMM-DSM has scheduled the deployment to run at the times that you specified. 

• Scheduled— The deployment is occurring now.

• Finished — The deployment occurred at the scheduled time and is now stopped.

Group The selection that you made from the DMP Groups list.
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In addition, a status bar at the bottom of the popup window counts the number of errors associated with 
the described deployment.

Start Command 
Summary 
(Total/OK/Failed)

N/N/N, where:

• The first N is a color-coded (white) numeral that counts the total number of times that DMM-DSM 
tried to deploy the command to start the designated task.

• The second N is a color-coded (green) numeral that counts the number of times that DMM-DSM 
succeeded in deploying the command to start the designated task.

• The third N is a color-coded (red) numeral that counts the number of times that DMM-DSM failed 
to deploy the command to start the designated task.

Stop Command 
Summary 
(Total/OK/Failed)

N/N/N, where:

• The first N is a color-coded (white) numeral that counts the total number of times that DMM-DSM 
tried to deploy the command to stop the designated task.

• The second N is a color-coded (green) numeral that counts the number of times that DMM-DSM 
succeeded in deploying the command to stop the designated task.

• The third N is a color-coded (red) numeral that counts the number of times that DMM-DSM failed 
to deploy the command to stop the designated task.

Table 3-21 Elements to Describe the Current Status of Scheduled Events (continued)

Category Description
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Preempting a Recurring Event for a One-time Event
In some cases, you might want to show a presentation one time, or for a limited time, that overlaps with 
a recurring deployment. 

For example, you might schedule a presentation to run from 9:00 a.m. to 6:00 p.m. every weekday in the 
month of March, but want to show a different presentation on the second Tuesday in March. The problem 
in this scenario is that your DMP cannot prioritize contradictory events that are scheduled to start 
simultaneously. However, there are three possible methods that you might use to schedule a preemption. 
In this scenario, you can do any of the following:

Using Deployment Reports
You can view, configure, and export “proof-of-play” reports for the presentations and tasks that you have 
deployed in your digital signage network.

Step 1 Choose Schedules > Reports.

Step 2 Check the check boxes for the relevant DMP groups.

Step 3 Enter date range values in the From field and the To field.

Method 1 1. Schedule and deploy a recurring event for the first uninterrupted span of dates.

2. Schedule and deploy the one-time event.

3. Schedule and deploy a copy of the first recurring event for the second uninterrupted span of dates.

Method 2 Create two DMP groups. In this scenario, we will call them Group_A and Group_B. 

• For Group_A, schedule an event that recurs throughout the entire span of dates. 

• For Group_B, schedule the one-time event. 

Then complete these steps:

1. When the one-time event should begin, move your DMPs from Group_A to Group_B.

2. When the one-time event should end, move your DMPs back to Group_A, then select Schedules > 
Play Now.

3. In the DMP Groups object selector, click the Group_A name to see its member DMPs in the 
untitled table.

4. In the untitled table, Ctrl-click each DMP that should start again to show the recurring 
presentation.

5. Choose Select an Event Type > Digital Signage and then click Select Digital Signage.

6. Click the presentation name and then click OK.

Method 3 1. Schedule the recurring event to run every weekday, as you would expect, from 9:00 a.m. to 
6:00 p.m.

2. Use one-time scheduling to start an advanced task (such as the Go to URL task, if the event is a 
live video stream) at 9:05 a.m, so that it interrupts the recurring event instead of conflicting with 
its start time, and then schedule this one-time event to stop at 6:00 p.m. 

In this method, the one-time event cannot be a presentation; it must be an advanced task. The recurring 
task will begin again, as expected, the next day.
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Step 4 From the Report Type list, select the report type.

Step 5 Click Go.

Using Administrative Options
This section contains these topics:

• Configuring User Rights and Permissions for Digital Signage and Enterprise TV, page 3-82

• Limiting User Permissions, page 3-84

• Configuring DMM-DSM Server Settings, page 3-87

• Configuring DMM-DSM to Use ACNS, page 3-87

• Configuring DMM-DSM to Deploy to External Servers, page 3-88

• Testing for the Presence of, and Obtaining, the Required Java Version, page 3-89

Configuring User Rights and Permissions for Digital Signage and Enterprise TV
In DMM-DSM, you can manage access rights and permission levels for administrators and members of 
the Digital Signage user group that is managed at a higher level in DMS-Admin. The rights and 
permissions that you manage in DMM-DSM are ones that pertain to digital signage and enterprise TV. 

Tip To understand the high-level concepts and workflow for managing user accounts, access rights, and 
permission levels, see Understanding User Management Concepts and Workflow, page 2-5.

Before You Begin

To see and use the Settings tab, you must be logged in an administrator.

Step 1 Choose Settings > User Accounts, then choose the options that meet your requirements. If you do not 
understand your options, see Table 3-22 on page 3-83.

Step 2 Click Submit.
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Table 3-22 Elements for Configuring DMM-DSM User Accounts

Element Icon and Description

Users List Select an account whose digital signage or enterprise TV access rights and permission levels you will edit. When 
you click a username, DMM-DSM automatically shows the Change User pane for the corresponding user account. 

Change User A worksheet where you edit attributes of the selected user account. 

— Name — A unique username. The name is unique in the sense that you have not used it as the name for 
any other user account that you created in DMM-DSM. You must enter the username.

— Description — Optional, brief description of the user account and its purpose.

— Password | Repeat— The password for the user account. You must enter a password, then reenter it.

— Administrator — The check box to select if this account belongs to an administrator. Otherwise, deselect 
the check box. When a user account belongs to an administrator, the corresponding user is granted full 
permissions to create, read, write, and delete every object type without limitation. If you deselect the 
check box, you must manually change the permissions for each user role and each object type that pertain 
to this user account. Because we recommend that you follow a best practice in which you create only a 
few users, the check box is selected by default each time that you add a user account. 

— Role—The list of user role types. Each type of role is associated with some of the features in DMM-DSM. 
Select a role to see or change the corresponding permissions for the user whose account you are adding or 
editing. After you select a role, you can set the permissions to create, read, write, and delete objects that are 
relevant to whichever role you selected. Depending on the user role that you select, an object might be a 
registered DMP, a registered FTP server, a category in your digital media library, an application that you 
configured, or the target device (DMP or FTP server) to receive a scheduled deployment.

• DMP Manager — A user with permissions to manage every DMP in your digital signage network, 
only the DMPs within particular DMP groups that you specify, or no DMPs whatsoever.

• Content Manager — A user with permissions to manage every category in your media library, only 
the particular categories that you specify, or none of the categories.

• Application Manager — A user with permissions to work with every application type, only the 
particular application types that you specify, or no applications of any kind.

• Publisher Manager— A user with permissions to schedule media deployments to all of your 
registered DMPs and external (FTP) deployment servers, only the particular DMPs and FTP servers 
that you specify, or none of the registered DMPs or FTP servers.

— The untitled table sorts user account permissions information into these rows:

• Objects — Contains the Create, Read, Write, and Delete buttons. To see or edit any one of these types 
of permissions as it applies to the specified user, you must first click the corresponding button. If you 
deselect both the All check box and the Selected check box in the column under a button, 
DMM-DSM automatically shows the words “No permissions” in red, to signify that the user does 
not have any permissions of that type in relation to the objects that are relevant to the role that you 
selected from the Role list.

• All — Contains the check box that you select to assign global permissions to the user, so that he or 
she can always {create | see | edit | delete} objects that pertain to whichever user role you selected 
from the Role list. Click the relevant button, then select the corresponding check box in the All row. 

• Selected—Contains the check box that you select to assign limited permissions to the user, so that he or 
she can {create | see | edit | delete} only a subset of the objects that pertain to the user role that you selected 
from the Role list. Click the relevant button, select the corresponding check box in the Selected row, then 
select the subset where the user permissions should apply. (Depending on the object type, you might 
choose the subset by clicking its name in an object selector or clicking its name in a table; DMM-DSM 
automatically shows either an object selector or a table from which to select the subset.)
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Limiting User Permissions
You can restrict the permissions that you grant to particular user accounts in DMM-DSM. For example, 
you might grant a user the permission to use only the advanced tasks that you choose or to deploy 
presentations to only the DMPs that you choose.

The list of “applications” that this section describes includes two applications (called “Enterprise TV” 
and “Enterprise TV VoD”) in addition to the full list of advanced tasks. Each Enterprise TV user must 
have at least read-only permission to the “Enterprise TV” application, which pertains to the electronic 
program guide.

Tip To understand the high-level concepts and workflow for managing user accounts, access rights, and 
permission levels, see Understanding User Management Concepts and Workflow, page 2-5.

Before You Begin

To see and use the Settings tab, you must be logged in an administrator.

Step 1 Choose Settings > User Accounts.

Step 2 In the Users list, click a username to highlight it. DMM-DSM automatically shows the Change User pane 
for the corresponding user account, where you can edit the permissions that apply to the user.

Step 3 Make selections to limit any or all of the permissions that you will grant to the user. 

If you do not understand your options, see Table 3-22 on page 3-83 or consider the examples in these 
scenarios:

• Scenario 1: User Who Can Work with Assets for Signage or Enterprise TV but Cannot Schedule 
Time Slots, page 3-84

• Scenario 2: User Who Can Administer One DMP Group but Cannot Manage Assets, page 3-85

• Scenario 3: User Who Can Administer One DMP Group, Manage Assets, and Schedule Time Slots, 
page 3-86

• Scenario 4: User Who Can Schedule Time Slots for One DMP Group But Has No Other Rights, 
page 3-86

By limiting permissions in specific ways, similar to the ways that these examples demonstrate, you can 
assign highly specialized combinations of access to any DMM-DSM user. The examples in these 
scenarios describe some of the commonest types of limited permissions that you might want to assign 
and tell you how to assign them.

Step 4 After you have selected the options to meet your requirements, click Submit.

Scenario 1: User Who Can Work with Assets for Signage or Enterprise TV but Cannot Schedule 
Time Slots

To restrict user permissions as they should be restricted in this scenario, you would do the following.

1. From the Role list, select DMP Manager, select the All check box in the Read column, then deselect 
every check box in the Create, Write, and Delete columns. 

2. From the Role list, select Content Manager, then select the All check box in the Create, Read, 
Write, and Delete columns. 
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3. From the Role list, select Application Manager, then select the Selected check box in the Create, 
Read, Write, and Delete columns. Next, do all of the following:

• Click Create, then — in the table that associates permissions with applications— select only 
these check boxes: Digital Media Designer, Enterprise TV, Enterprise TV VoD, and Go 
to URL.

• Click Read, then — in the table that associates permissions with applications— select only these 
check boxes: Digital Media Designer, Enterprise TV, Enterprise TV VoD, and Go to URL.

• Click Write, then — in the table that associates permissions with applications— select only 
these check boxes: Digital Media Designer, Enterprise TV, Enterprise TV VoD, and Go 
to URL.

• Click Delete, then — in the table that associates permissions with applications— select only 
these check boxes: Digital Media Designer, Enterprise TV, Enterprise TV VoD, and Go 
to URL.

4. From the Role list, select Publisher Manager, select the All check box in the Read column, then 
deselect every check box in the Create, Read, Write, and Delete columns. 

5. Click Submit.

Scenario 2: User Who Can Administer One DMP Group but Cannot Manage Assets

To restrict user permissions as they should be restricted in this scenario, you would do the following.

1. From the Role list, select DMP Manager, then select the Selected check box in the Create, Read, 
Write, and Delete columns. Next, do all of the following:

• Click Create. Then, in the object selector, click a DMP group to highlight it. 

• Click Read. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for Create permissions. 

• Click Write. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for Create permissions.

• Click Delete. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for Create permissions.

2. From the Role list, select Content Manager, then deselect every check box in the Create, Read, 
Write, and Delete columns.

3. From the Role list, select Application Manager, then — in the table that associates permissions with 
applications— select only these check boxes: DMP Discovery, DMP Video/Audio Settings, 
System Tasks, DMP Firmware Upgrade.

4. From the Role list, select Publisher Manager, then select the Selected check box in the Create, 
Read, Write, and Delete columns. Next, do all of the following:

• Click Create. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for the DMP Manager role. 

• Click Read. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for the DMP Manager role. 

• Click Write. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for the DMP Manager role.

• Click Delete. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for the DMP Manager role.
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5. Click Submit.

Scenario 3: User Who Can Administer One DMP Group, Manage Assets, and Schedule Time Slots

To restrict user permissions as they should be restricted in this scenario, you would do the following.

1. From the Role list, select DMP Manager, then select the Selected check box in the Create, Read, 
Write, and Delete columns. Next, do all of the following:

• Click Create. Then, in the object selector, click a DMP group to highlight it. 

• Click Read. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for Create permissions. 

• Click Write. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for Create permissions.

• Click Delete. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for Create permissions.

2. From the Role list, select Content Manager, then select the All check box in the Create, Read, 
Write, and Delete columns. 

3. From the Role list, select Application Manager, then — in the table that associates permissions with 
applications— select every check box.

4. From the Role list, select Publisher Manager, then select the Selected check box in the Create, 
Read, Write, and Delete columns. Next, do all of the following:

• Click Create. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for the DMP Manager role. 

• Click Read. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for the DMP Manager role. 

• Click Write. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for the DMP Manager role.

• Click Delete. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for the DMP Manager role.

5. Click Submit.

Scenario 4: User Who Can Schedule Time Slots for One DMP Group But Has No Other Rights

To restrict user permissions as they should be restricted in this scenario, you would do the following.

1. From the Role list, select DMP Manager, select the All check box in the Read column, then deselect 
every check box in the Create, Write, and Delete columns.

2. From the Role list, select Content Manager, then deselect every check box in the Create, Read, 
Write, and Delete columns. 

3. From the Role list, select Application Manager, select the All check box in the Read column, then 
deselect every check box in the Create, Write, and Delete columns.

4. From the Role list, select Publisher Manager, then select the Selected check box in the Create, 
Read, Write, and Delete columns. Next, do all of the following:

• Click Create. Then, in the object selector, click a DMP group to highlight it. 

• Click Read. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for Create permissions. 
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• Click Write. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for Create permissions.

• Click Delete. Then, in the object selector, click and highlight the same DMP group that you 
highlighted for Create permissions.

5. Click Submit.

Configuring DMM-DSM Server Settings
You must configure DMM-DSM to use the correct Java servlet server and to use one, consistent 
username and password for administrative access to all of the DMPs that you will manage centrally.

Before You Begin

To see and use the Settings tab, you must be logged in an administrator.

Step 1 Choose Settings > Server Settings.

Step 2 In the Servlet Server Address field, enter the routable IP address or resolvable DNS hostname for your 
DMM appliance. It will not be updated automatically if you use AAI to change the IP address of your 
DMM appliance.

Step 3 In the DMP User Name field, enter the one administrative username that you have configured all of your 
DMPs to share.

Step 4 In the DMP User Password field, enter the one administrative password that you have configured all of 
your DMPs to share.

Step 5 Click Save.

Configuring DMM-DSM to Use ACNS
You can configure DMM-DSM to use ACNS.

Caution Never delete an ACNS channel that Cisco DMS uses. If you do, you will not be able to see, select, edit, 
or delete in your schedule any events that use the deleted channel. Failover (content substitution) occurs 
on your DMPs when scheduled events call upon missing assets. Before you delete any ACNS channel, 
be sure that you have deleted from your schedule all events that will be disrupted otherwise.

Before You Begin

To see and use the Settings tab, you must be logged in an administrator.

Step 1 Choose Settings > ACNS, then select the options that meet your requirements. If you do not understand 
your options, see Table 3-23 on page 3-88.

Step 2 Click Save.
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Configuring DMM-DSM to Deploy to External Servers
You can configure DMM-DSM to deploy to external servers, but only within these operating parameters: 

• The only supported server type is FTP in this release. 

• You cannot use the Schedules > Play Now feature with external deployment servers.

• All deployments to your external deployment servers require that you use the Schedules > Play in 
Future feature. 

Before You Begin

To see and use the Settings tab, you must be logged in an administrator.

Step 1 Choose Settings > External Deployment Locations, then select the options that meet your 
requirements. If you do not understand your options, see Table 3-24 on page 3-88.

Step 2 Click Save.

Table 3-23 Elements for Using ACNS

Element Description

CDM Address The routable IP address or resolvable DNS hostname of the appliance or services module (“blade”) 
that runs ACNS and Content Distribution Manager software.

Port The TCP port for login access to CDM. The port number by default is 8443.

User The username for login access to CDM.

Password The password that corresponds to the CDM username that you entered.

Table 3-24 Elements to Configure Deployments to External Servers

Element Icon and Description

External Publishing 
Server List

Add, select, edit, or delete external deployment (FTP) servers.

— Click a server to highlight it, so that you can edit or delete it. DMM-DSM automatically shows 
the Change External Publishing Server pane for the corresponding server, where you can edit 
its settings.

Add New External Publishing Server — Shows the Add New External Publishing Server pane, 
where you can define the settings to use a new server. 

Delete External Publishing Server— Deletes the server that you highlighted.
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Testing for the Presence of, and Obtaining, the Required Java Version
You can test for the presence on your PC of the Java Runtime Engine version that DMM-DSM requires. 
If the required version is not installed, DMM-DSM tells you where you can download it.

Tip To understand all of the prerequisites to use DMS and its components, including DMM-DSM, see 
Release Notes for Cisco Digital Media System 5.0 on Cisco.com.

Step 1 Choose Help > Downloads, and then click Check Java Plugin.

A popup window opens. If the correct Java version is installed, a message tells you so. Otherwise, 
DMM-DSM directs you to download the required version.

{Add New | Change} 
External Publishing 
Server

Add or edit attributes of the external servers that you use for deployments. Each of your external 
publishing servers most run the necessary services to function both as an http server and as an ftp 
server. In addition, the root-level directory for ftp must be equal to or under the root-level directory 
for http. For example, you might use /wwwroot for http and /wwwroot/ftproot for ftp.

— Host — The routable IP address or resolvable DNS hostname of the external deployment (FTP) 
server. You must enter this value.

— Port— The port number to use. You can use any port number, but the default is 21.

— Server Type — FTP.

— Remote Directory — Corresponding to the same server directory structure that you reference 
when you enter an HTTP Mapping value (see the row below this one), enter the root-level 
deployment directory to use on your external publishing server when your communications 
protocol is ftp. For example, you might enter only a forward slash (/).

— HTTP Mapping — Corresponding to the same server directory structure that you reference 
when you enter a Remote Directory value (see the row above this one), enter the root-level 
deployment directory to use on your external publishing server when your communications 
protocol is http. For example, you might enter /ftproot.

— HTTP Port — Enter the port number to use on the external deployment server. You can use any 
port number. If you do not enter a port number, the default is to use port 80.

— User Name— Enter the FTP username. It is acceptable to use the name anonymous.

— Password | Confirm Password — You must enter the FTP password, then reenter it.

Table 3-24 Elements to Configure Deployments to External Servers (continued)

Element Icon and Description
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Common Scenarios for Using DMM-DSM
This section describes common scenarios for using DMM-DSM.

• Uploading Files to a DMP for Local Storage and Immediate Deployment, page 3-90

Uploading Files to a DMP for Local Storage and Immediate Deployment
You can create a presentation that shows video files from a playlist, then transfer the presentation and 
its assets to the local Secure Digital (SD) flash memory card in a DMP for playback on its attached 
DMP display.

Note • The total amount of available file space for local storage is:

– 0.9 GB (900 MB) on a DMP 4300G.

– 1.9 GB on a DMP 4305G. 

– 3.8 GB on a DMP 4400G.

Consider these SD memory card capacities carefully when you make designs for use during 
stage-one failover. The combined file size for all assets in such designs cannot exceed the storage 
capacity of the SD card. To check the free space on the SD memory card in a DMP, log in to its local 
instance of DMPDM, then click Internal Storage. To understand failover, see the “Understanding 
Content Substitution (Failover)” topic in User Guide for Cisco Digital Media Player Device 
Manager 5.0 on Cisco.com.

• A presentation cannot play any file with a file size greater than 1.9 GB on a DMP, regardless of its 
model type. This size is constrained by the limits of streaming.

Before You Begin

To learn how to create a playlist in Digital Media Designer, so that you can show the playlist as part of 
a presentation, see Creating and Organizing Presentation Playlists, page 3-49.

Step 1 To create an advanced task that will transfer the assets for your playlist anywhere in your digital signage 
network, select Digital Media Players > Advanced Tasks > File Transfer to DMP or Server, then do 
the following:

a. Click Add New Application, then enter a name for the new file transfer task in the Name field; 
for example, you might enter the name LocalPublishing. 

You must enter a name. The name is unique in the sense that you have not used it previously as the 
name for anything that can be scheduled.

b. In the Applications list, click Digital Media Designer.

c. In the Available Content table, click a row to highlight the presentation, then click Select 
Applications. Doing this moves the highlighted presentation to the Selected Content table, so that 
its assets become available for deployment. 

d. To save your work, click Submit.
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Step 2 To deploy the file transfer task to a DMP or DMP group, select Schedules > Play Now, then do 
the following:

a. From the DMP Groups object selector, select the DMP or DMP group that should receive 
the deployment.

b. From the Actions list, select the name of the advanced task that you configured and saved for this 
file transfer operation, then click Go.

DMM-DSM deploys the assets and commands immediately to the DMPs that you selected, and the 
targeted DMPs restart automatically. 

Note • After they restart, your DMPs will not show the newly received presentation automatically on their 
attached DMP displays. The presentation will not play unless stage-one failover occurs or until you 
deploy the Go to URL task that DMM-DSM generated automatically when you deployed assets to 
the SD memory card. 

• After you create and deploy any “File Transfer to DMP or Server” task to save the assets from a 
DMD presentation to the SD memory card inside a DMP, DMM-DSM automatically creates a Go to 
URL task. The name by default for the Go to URL task is “failover - <name_of_presentation>.” If 
any of your DMPs should show the presentation at any time other than during stage-one failover, 
you must deploy the corresponding Go to URL task to those DMPs. See Scheduling Time Slots for 
Media and Events on DMPs, page 3-73.

• After you delete a presentation for which DMM-DSM automatically generated a corresponding Go 
to URL task, you must also delete that Go to URL task.
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